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Preface

Revision history

Revision Date Description
A September 2008 | New document.
B ' September 2010 " Remove patent numbers.
C April 2011 | Remove patent numbers.
D March 2012 Update legal information.
E August 2014 | Add information about 50-, 100-, and 1000-reaction
kit sizes.
F February 2015 Add information for the ProFlex™ PCR System.

Purpose

The Applied Biosystems® AmpFISTR® Identifiler® Plus PCR Amplification Kit User
Guide provides information about the Applied Biosystems® instruments,
chemistries, and software associated with the AmpF(STR® Identifiler® Plus PCR
Amplification Kit.

Pull-out chapters

This guide is designed to allow users to pull out chapters 2, 3, and 4. The pull-out
chapters have title and back pages, which indicate the chapter number and title.
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Overview

This chapter covers:
B Productoverview.............
B Workflow overview . ..........
B Instrument and software overview

B Materials and equipment. . . .. ..
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Chapter 1 Overview

Product overview

Purpose

Product
description

About the primers

The AmpF(STR® Identifiler® Plus PCR Amplification Kit is a short tandem repeat
(STR) multiplex assay that amplifies 15 tetranucleotide repeat loci and the
Amelogenin gender-determining marker in a single PCR amplification:

+ All thirteen of the required loci for the Combined DNA Index System (CODIS)
loci are included in this kit for known-offender databasing in the United States
(Budowle et al., 1998).

» Two additional loci, D2S1338 and D19S433, are included. These loci are
consistent with the AmpF{STR SGM Plus™ PCR Amplification Kit.

» The combination of the 15 loci are consistent with several worldwide database
recommendations.

The AmpF{STR Identifiler Plus Kit delivers a 16-locus multiplex with the same
power of discrimination as, better sensitivity than, and better robustness than the
earlier generation of the AmpF{STR Identifiler Kit. The kit uses modified PCR
cycling conditions for enhanced sensitivity, a new buffer formulation to improve
performance with inhibited samples, and an improved process for DNA synthesis
and purification of the amplification primers to deliver a much cleaner
electrophoretic background.

The AmpF{STR Identifiler Plus Kit uses the same primer sequences as the earlier
generation AmpF{STR® Identifiler® Kit. The AmpF{STR Identifiler Plus Kit
contains all the necessary reagents for the amplification of human genomic DNA.

The reagents are designed for use with the following Applied Biosystems®
instruments:

* Applied Biosystems® 3100/3100-Avant Genetic Analyzer

+ Applied Biosystems® 3130/3130x/ Genetic Analyzer

+ Applied Biosystems® 310 Genetic Analyzer

+  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

*  Veriti® 96-Well Thermal Cycler

+ ProFlex " PCR System

The AmpF{STR Identifiler Plus Kit employs the latest improvements in primer
synthesis and purification techniques to minimize the presence of dye-labeled
artifacts. These improvements result in a much cleaner electropherogram
background that enhances the assay's signal-to-noise ratio and simplifies the
interpretation of results.

Non-nucleotide linkers are used in primer synthesis for the following loci: CSF1PO,
D13S317,D16S539, D2S1338, and TPOX. For these primers, non-nucleotide linkers
are placed between the primers and the fluorescent dye during oligonucleotide
synthesis (Butler, 2005, Grossman et al., 1994, and Baron et al., 1996).
Non-nucleotide linkers enable reproducible positioning of the alleles to facilitate

10
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Product overview

Loci amplified by

the kit

interlocus spacing. The combination of a five-dye fluorescent system and the
inclusion of non-nucleotide linkers allows for simultaneous amplification and
efficient separation of the 15 STR loci and Amelogenin during automated DNA
fragment analysis.

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AmpF{STR® Identifiler® Plus Allelic
Ladder is used to genotype the analyzed samples. The alleles contained in the allelic
ladder, and the genotype of the AmpF(STR® Identifiler® Plus Control DNA 9947A
are also listed in the table.

Table 1 AmpF(STR® Identifiler® Plus Kit loci and alleles

Locus designation Chromosome Alleles included in Identifiler® Plus Dye ControlDNA
9 location Allelic Ladder label 9947A
D8S1179 8 8,910,11,12,13,14,15,16,17, 18, 19 6-FAM™ 13%
D21S11 21q11.2-g21 24,24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30§
30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2,
35, 35.2, 36, 37, 38
D7S820 7911.21-22 6,7,8,9,10,11,12,13, 14,15 10, 11
CSF1PO 5033.3-34 6,7,8,9,10,11,12,13, 14,15 10, 12
D3S1358 3p 12,13, 14,15,16, 17,18, 19 vIC® 14,15
THO1 11p15.5 4,5,6,7,8,9,9.3,10,11,13.3 8,9.3
D13S317 13922-31 8,9,10, 11,12, 13, 14,15 11#
D16S539 16g24-gter 5,8,9,10, 11,12,13, 14,15 11,12
D2S1338 2q35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 19, 23
26, 27, 28
D19S433 19912-13.1 9,10, 11,12, 12.2, 13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2,16,16.2,17,17.2
vWA 12p12-pter 11,12,13, 14, 15,16, 17,18, 19, 20, 21, 22, 17,18
23,24
TPOX 2p23-2per 6,7,8,9,10,11,12,13 g+
D18S51 18921.3 7,9,10,10.2,11,12,13,13.2, 14, 14.2, 15, 15,19
16,17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27
Amelogenin X: p22.1-22.3 X, Y PET® X
Y: p11.2
D5S818 5921-31 7,8,9,10,11,12,13, 14, 15, 16 118§
FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 23,24
27,28, 29, 30, 30.2, 31.2, 32.2, 33.2,42.2,
43.2,44.2,45.2,46.2,47.2,48.2,50.2, 51.2
1 For CODIS purposes, profile reported as 13, 13.
§ For CODIS purposes, profile reported as 30, 30.
# For CODIS purposes, profile reported as 11, 11.
11 For CODIS purposes, profile reported as 8, 8.
§§ For CODIS purposes, profile reported as 11, 11.
AmpFISTR® Identifiler® Plus User Guide 11
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Iadder

Iadder

Iadder

I=dder

Allelic ladder Figure 1 shows the allelic ladder for the AmpF{STR Identifiler Plus Kit. See “Allelic

profile ladder requirements” on page 36 for information on ensuring accurate genotyping.
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Figure 1 GeneMapper® ID-X Software plot of the AmpF(STR® Identifiler® Plus
Kit Allelic Ladder
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Control DNA  Figure 2 shows amplification of Control DNA 9947A using the AmpF{STR
9947A profile Identifiler Plus Kit.
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Figure 2 1 ng of Control DNA 9947A amplified with the AmpF{STR® Identifiler®
Plus Kit and analyzed on the Applied Biosystems® 3130x/ Genetic Analyzer
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Workflow overview
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Instrument and software overview

Instrument and software overview

This section provides information about the Data Collection Software versions
required to run the AmpF¢STR® Identifiler® Plus PCR Amplification Kit on specific
instruments.

Data Collection The Data Collection Software provides instructions to firmware running on the
and instrument and displays instrument status and raw data in real time. As the
GeneMapper® ID  instrument measures sample fluorescence with its detection system, the Data
or ID-X Software Collection Software collects the data and stores it. The Data Collection Software
stores information about each sample in a sample file (.fsa), which is then analyzed
by the GeneMapper® ID or ID-X Software.

Instrument and

software Instrument Datg Collection Analysis software
el rps oftware
compatibility
3500/3500xL 3500 Series GeneMapper® ID-X Software
Data Collection v1.2 or later
Software v1.0 or
later
3130/3130x/* 3.0 or later e GeneMapper® ID
Software v3.2.1
212%3100— 1.1 (3100) and
1.0 (31 OO—Avant) . GeneMapper® ID-X
Software v1.0.1 or later
2.0
310 3.1
3.0

T We conducted validation studies for the AmpFlSTR® Identifiler® Plus Kit using
this configuration.

About  Applied Biosystems® fluorescent multi-color dye technology allows the analysis of
multicomponent multiple loci, including loci that have alleles with overlapping size ranges. Alleles for
analysis overlapping loci are distinguished by labeling locus-specific primers with different
colored dyes.

Multicomponent analysis is the process that separates the five different fluorescent
dye colors into distinct spectral components. The four dyes used in the AmpF(STR®
Identifiler® Plus PCR Amplification Kit to label samples are 6-FAM™, VIC®,
NED™, and PET® dyes. The fifth dye, LIZ® dye, is used to label the GeneScan"" 500
LIZ® Size Standard.

AmpFISTR® Identifiler® Plus User Guide 15
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How
multicomponent
analysis works

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems® and ABI PRISM®
instruments, the fluorescence signals are separated by diffraction grating according
to their wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM™ dye emits at the shortest wavelength and it
is displayed as blue, followed by the VIC® dye (green), NED™ dye (yellow), PET®
dye (red), and LIZ® dye (orange).

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes
(Figure 3). The goal of multicomponent analysis is to correct for spectral overlap.

Dyes

6-FAM VIC NED PET LIZ
c 100 1 1 1 1 1
e} 4
3 80 A
E 4
L 60 4
3 |
N 40
© |
g 20 1 \
o |
=z 0 —

T T T T T T T T T T T T T T T T T T T T

500 550 600 650 700

Wavelength (nm)

Figure 3 Emission spectra of the five dyes used in the AmpF(STR® Identifiler®
Plus Kit
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Materials and equipment

Materials and equipment

Kit contents and

The AmpF(STR® Identifiler® Plus PCR Amplification Kit contains materials

storage sufficient to perform 50, 100, 200, or 1000 amplifications at 25 UL reaction volumes.
IMPORTANT! The fluorescent dyes attached to the primers are light sensitive.
Protect the primer set from light when not in use. Amplified DNA, AmpF(STR®
Identifiler® Plus Allelic Ladder, and GeneScan™ 500 LIZ® Size Standard should also
be protected from light. Keep freeze-thaw cycles to a minimum.
50X 100X 200X 1000X
Component Description Volume Volume Volume Volume Storage
(A26182) | (A26364) (4427368) (4486467)
AmpF{STR® Contains enzyme, salts, 1 tube, 2 tubes, 2 tubes, 10 tubes, -15to -25°C on
Identifiler® Plus  |dNTPs, carrier protein, and |0.5 mL 0.5 mL/tube | 1.0 mL/tube |1.0 mL/tube |receipt, 2 to 8 °C
Master Mix 0.04% sodium azide. after initial use
AmpF{STR® Contains 0.10 ng/pL human |1 tube, 1 tube, 1 tube, 5 tubes,
Control DNA female 9947A DNA in 0.05% |0.3 mL 0.3 mL 0.3 mL 0.3 mL/tube
9947A sodium azide and buffer®.
See Table 1 on page 11 for
profile.
AmpF{STR® Contains forward and 1 tube, 2 tubes, 1 tube, 5 tubes, -15to -25°C on
Identifiler® Plus  |reverse primers to amplify [0.25mL  |0.25 mL/tub|1.0 mL 1.0 mL/tube |receipt, 2 to 8 °C
Primer Set human DNA targets. e after initial use.
AmpF{STR® Contains amplified alleles. |1 tube, 1 tube, 1 tube, 5 tubes, ﬁz)c;;elil;’mtected
Identifiler® Plus 0.025mL [0.025mL [0.05mL 0.05 mL/tube :
Allelic Ladder See Table 1 on page 11 fora

list of alleles included in the
allelic ladder.

T The AmpFlSTR® Control DNA 9947A is included at a concentration appropriate to its intended use as an amplification control (i.e., to
provide confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpFlSTR® Control DNA
9947A is not designed to be used as a DNA quantitation control, and laboratories may expect to see variation from the labelled

concentration when quantitating aliquots of the AmpF{STR® Control DNA 9947A.

Standards for
samples

For the AmpF{STR Identifiler Plus Kit, the panel of standards needed for PCR
amplification, PCR product sizing, and genotyping are:

* Control DNA 9947A — A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the AmpF(STR® Identifiler® Plus
Allelic Ladder.

+ GeneScan'" 500 LIZ® Size Standard — Standard used for obtaining sizing
results. It contains 16 single-stranded labeled fragments of: 35, 50, 75, 100, 139,
150, 160, 200, 250, 300, 340, 350, 400, 450, 490 and 500 nucleotides. This
standard, which has been evaluated as an internal lane size standard, yields
precise sizing results for AmpF{STR Identifiler Plus Kit PCR products. Order

the GeneScan 500 LIZ Size Standard (PN 4322682) separately.

+  AmpF(STR® Identifiler® Plus Allelic Ladder — Allelic ladder for accurate
characterization of the alleles amplified by the AmpF{STR Identifiler Plus Kit.
The AmpF(STR® Identifiler® Plus Allelic Ladder contains most of the alleles
reported for the 15 autosomal loci. Refer to Table 1 on page 11 for a list of the
alleles included in the AmpF{(STR® Identifiler® Plus Allelic Ladder.

AmpFISTR® Identifiler® Plus User Guide
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Chapter 1 Overview

Equipment and Tables 2 and 3 list required and optional equipment and materials not supplied with
materials not the AmpF(STR Identifiler Plus Kit. Unless otherwise noted, many of the items are

included available from major laboratory suppliers (MLS).

Table 2 Equipment

Equipment

Source

ABI PrismM® 3100/3100-Avant Genetic Analyzer

Applied Biosystems® 3130/3130x/ Genetic Analyzer

Applied Biosystems® 310 Genetic Analyzer

Contact your local
sales representative

GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
ProFlex™ PCR System 4484075
Veriti® 96-Well Thermal Cycler 4375786
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS
Table 3 User-supplied materials*

Item Source
50-reaction AmpF{STR® Identifiler® Plus PCR Amplification Kit A26182
100-reaction AmpF{STR® Identifiler® Plus PCR Amplification Kit A26364
200-reaction AmpF{STR® Identifiler® Plus PCR Amplification Kit 4427368
1000-reaction AmpF{STR® Identifiler® Plus PCR Ampilification Kit 4486467
3100/3100-Avant Genetic Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

18
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Materials and equipment

Table 3 User-supplied materials* (continued)

Item Source
250-uL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the ABI Prism® 3100
Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (PN 4335393).

3130/3130x/ Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3130/3130x/ Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x/ instrument, refer to Appendix A of the Applied Biosystems®
3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (PN 4352716).

310 Analyzer materials

310 DNA Analyzer Capillary Array, 47-cm 402839
0.5 mL Sample Tray 5572
96-Well Tray Adaptor (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 4335643
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL) 401957
Septa for 0.5-mL Sample Tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC®, NED™, PET®, and LIZ® dyes) for 4318159
ABI PRISM® 310/377 systems

MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 96-Well Base (holds 0.2-mL reaction tubes) N8010531
MicroAmp® 96-Well Full Plate Cover N8010550

AmpFISTR® Identifiler® Plus User Guide 19
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Table 3 User-supplied materials* (continued)

Item Source
MicroAmp® 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

Analyzer User Guide (PN 4317588).

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the ABI PRISM® 310 Genetic

PCR Amplification

MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCI, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS

1 For the Material Safety Data Sheet (MSDS) of any chemical not distributed by Applied Biosystems®, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant precautions.

20
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This chapter covers:
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Chapter 2 PCR Amplification

PCR work areas

Work area setup
and lab design

PCR-setup tools

Many resources are available for the appropriate design of a PCR laboratory:

+ If you are using the AmpF{(STR® Identifiler® Plus PCR Amplification Kit for
forensic DNA testing, refer to Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving, National Institute of Justice, 1998
(http://nij.ncjrs.gov/publications/pubs_db.asp).

+ If you are using the AmpF/(STR® Identifiler® Plus Kit for parentage DNA
testing, refer to the Guidance for Standards for Parentage Relationship Testing
Laboratories, American Association of Blood Banks, 7th edition, 2004.

The sensitivity of the AmpF(STR® Identifiler® Plus Kit (and other PCR-based tests)
enables amplification of minute quantities of DNA, necessitating precautions to
avoid contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

To prevent contamination by human DNA, be careful while handling and processing
samples. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: These laboratory design resources and guidances constitute only a sample of
the precautions that need to be observed when using PCR technology. Refer to your
laboratory’s internal policies and procedures for additional information and
references.

IMPORTANT! These items should never leave the PCR setup work area.

» Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

*  Microcentrifuge tube rack

* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

* Tube decapper, autoclavable

* Vortex

Amplified DNA  The following PCR systems should be placed in the amplified DNA work area.

work area tools

»  GeneAmp® PCR System 9700 with the Silver 96-Well Block

+  GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block
*  Veriti® 96-Well Thermal Cycler

» ProFlex™ PCR System
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Required user-supplied reagents

Required user-supplied reagents

In addition to the AmpF(STR® Identifiler® Plus Kit reagents, the use of low TE
buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the
buffer as described in the procedure below or order it from Teknova (Cat # T0223).

To prepare low TE buffer:

1. Mix together:
* 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA quantification

Importance of Quantifying the amount of DNA in a sample before amplification allows you to

quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount
of DNA for the AmpF(STR® Identifiler® Plus Kit is 1.0 ng in a maximum input
volume of 10 puL for 28 PCR cycles and 0.5 ng in a maximum input volume of 10 uL.
for 29 PCR cycles.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data). Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

* Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur resulting in a partial profile.
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Chapter 2 PCR Amplification

Methods of We provide several kits for quantifying DNA in samples. See the reference cited in
quantifying DNA the following table for details about these kits.

Product Description References
Quantifiler® Human Properties: Quantifiler® Human
Eyﬁ:ﬁufgn:ggg;‘)on The Quantifiler® Human and Quantifiler® Y Human Male Kits are E:;?u%gigtll\f/ﬁit&(;?

highly specific for human DNA, and they individually detect total (PN 4344790)

and human or male DNA, respectively. The kits detect single-stranded
Quantifiler®Y Human = 2nd degraded DNA.

Male DNA How they work:
Quantification Kit

e e . . ) .
(PN 4343906) The Quantifiler® DNA Quantification Kits consist of target-specific

and internal control 5' nuclease assays.

The Quantifiler® Human and Quantifiler® Y Human Male Kits contain
different target-specific assays (human DNA or human male DNA,
respectively) that each consist of two locus-specific PCR primers
and one TagMan® MGB probe labeled with FAM™ dye for detecting
the amplified sequence. The kits each contain a separate internal
PCR control (IPC) assay, which consists of an IPC template DNA (a
synthetic sequence not found in nature), two primers for amplifying
the IPC template DNA, and one TagMan® MGB probe labeled with
VIC® dye for detecting the amplified IPC DNA.

Quantifiler® Duo Properties: Quantifiler® Duo DNA

DNA Quantification 0 o \antifiler® Duo Kit is highly specific for human DNA. This kit~ uantification Kit
Kit (PN 4387746) . . . User's Manual
combines the detection of both total human and male DNA in one (PN 4391294)

PCR reaction.The kit detects single-stranded and degraded DNA.
How it works:

The Quantifiler® Duo DNA Quantification Kit consists of target-
specific and internal control 5' nuclease assays.

The Quantifiler® Duo kit combines two human-specific assays in
one PCR reaction (for total human DNA and human male DNA). The
two human DNA specific assays each consist of two PCR primers
and a TagMan® probe. The TagMan® probes for the human DNA
and human male DNA assays are labeled with VIC® and FAM™
dyes, respectively. In addition, the kit contains an internal PCR
control (IPC) assay similar in principle to that used in the other
Quantifiler kits, but labeled with NED™ dye.
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DNA quantification

Product Description References

Quantifiler® HP DNA | Properties: Quantifiler HP and Trio
Quantification Kit DNA Quantification
(Cat. no. 4482911) Kits User Guide

and Quantifiler® Trio X . . P (Pub no. 4485354)
DNA Quantification designed to simultaneously quantify the total amount of amplifiable

Kit human DNA and human male DNA in a sample.
(Cat. no. 4482910) How it works:

The Quantifiler® HP and Trio DNA Quantification Kits use multiple-
copy target loci for improved detection sensitivity. The human-
specific target loci (Small Autosomal, Large Autosomal, and Y-
chromosome targets) each consist of multiple copies dispersed on
various autosomal chromosomes (Small Autosomal and Large
Autosomal), or multiple copies on the Y-chromosome (Quantifiler®
Trio Kit only).

The Quantifiler® HP Kit is designed to quantify the total amount of
amplifiable human DNA in a sample. The Quantifiler® Trio Kit is

To maximize the consistency of quantification results, genomic
targets were selected with conserved primer- and probe-binding
sites within individual genomes and also with minimal copy number
variability between different individuals and population groups. As a
result, the detection sensitivity of the Quantifiler® HP and Trio
assays is improved over Quantifiler® Duo, Human, and Y Human
Male DNA Quantification Kit assays. The primary quantification
targets (Small Autosomal and Y) consist of relatively short
amplicons (75 to 80 bases) to improve the detection of degraded
DNA samples. In addition, the Quantifiler® HP and Trio Kits each
contain a Large Autosomal target with a longer amplicon (>200
bases) to aid in determining if a DNA sample is degraded.
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Chapter 2 PCR Amplification

Prepare the amplification kit reactions

1. Calculate the volume of each component needed to prepare the reactions, using

the table below.
DNA sample Volume per reaction (uL)
AmpF{STR® Identifiler® Plus Master Mix 10.0
AmpF{STR® Identifiler® Plus Primer Set 5.0

Note: Include additional reactions in your calculations to provide excess
volume for the loss that occurs during reagent transfers.

2. Prepare reagents. Thaw the AmpF(STR® Identifiler® Plus Kit Master Mix and
the AmpF(STR® Identifiler® Plus Kit Primer Set, then vortex 3 seconds and
centrifuge briefly before opening the tubes.

IMPORTANT! Thawing is required only during first use of the kit. After first
use, reagents are stored at 2 to 8 °C and, therefore, they do not require
subsequent thawing. Do not refreeze the reagents.

3. Pipette the required volumes of components into an appropriately sized
polypropylene tube.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 15 uL of the reaction mix into each reaction well of a MicroAmp®
Optical 96-Well Reaction Plate or each MicroAmp® tube.

6. Prepare the DNA samples:

DNA sample To prepare...

Negative control Add 10 pL of low TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).

Test sample Dilute a portion of the test DNA sample with low TE buffer so
that 1.0 ng of total DNA is in a final volume of 10 uL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 pL of 9947A control DNA (0.1 ng/uL).

The final reaction volume (sample or control plus reaction mix) is 25 pL.

7. Seal the MicroAmp® Optical 96-Well Reaction Plate with MicroAmp® Clear
Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.

8. Vortex the reaction mix for 3 seconds, then centrifuge the tubes at 3000 rpm for
about 20 seconds in a tabletop centrifuge (with plate holders if using 96-well
plates) to remove bubbles.
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Select the appropriate PCR cycle number

9. Amplify the samples in a GeneAmp® PCR System 9700 with the silver 96-well
block, a GeneAmp® PCR System 9700 with the gold-plated silver 96-well
block, a Veriti® 96-Well Thermal Cycler, or a ProFlex " PCR System.

Note: The AmpF(STR® Identifiler® Plus Kit is not validated for use with the
GeneAmp PCR System 9700 with the aluminium 96-well block. Use of this
thermal cycling platform may adversely affect performance of the AmpF(STR®
Identifiler® Plus Kit.

Select the appropriate PCR cycle number

All AmpF(STR® kits are optimized for a specific number of amplification cycles to
deliver well-balanced and high quality results. However, increases in the number of
low-level DNA samples being submitted for analysis have prompted many
laboratories to evaluate increasing the number of amplification cycles to increase the
sensitivity of the assay. Before increasing the cycle number, perform a
comprehensive validation study to establish new performance criteria for the higher
cycle number.

Higher cycle numbers can cause the following to occur:

» Exaggerated stochastic effects resulting from low DNA input amounts

Greater difference between the presence and absence of an allele
* Greater heterozygote peak imbalance

Possible differences in expected stutter position and percentage

* Possible increase in artifacts and/or background in the profile to accompany the
increase in sample allele signal

The Identifiler® Plus Kit offers two PCR-cycle-number options:

» Standard 28-PCR-cycle protocol — Provides high sensitivity to consistently
generate full STR profiles with 125 pg of DNA input. Use with the optimum
1.0 ng DNA input amount in a maximum input volume of 10 puL.

* 29-PCR-cycle protocol — Adds the extra sensitivity when amplifying <125 pg
DNA inputs. Recommended for use when the total DNA input amount is
<0.5 ng.

The results of the developmental validation at both PCR cycle numbers is presented
in Chapter 5 on page 77.
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Chapter 2 PCR Amplification

Perform PCR

m WARNING! PHYSICAL INJURY HAZARD. Thermal cycler.

1. Program the thermal cycling conditions:

*  When using the GeneAmp PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

+  When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal
Cycler AmpF(STR® Kit Validation (PN 4440754).

+  When using the ProFlex™ PCR System, refer to the ProFlex" PCR System
Kit Validation User Bulletin (Pub. no. 100031595) for more information.

Initialincubation Cycle (28 or 29 cycles?) Final Final hold
step Denature Anneal/Extend extension
HOLD CYCLE HOLD HOLD
95 °C 94 °C 59 °C 60 °C 4°C
11 min 20 sec 3 min 10 min Up to 24
hours$

T Refer to the previous section for selecting the appropriate PCR cycle number
§ The infinity setting (e) allows an unlimited hold time.

2. Load the plate into the thermal cycler and close the heated cover.

IMPORTANT! Ifusing adhesive clear film instead of caps to seal the plate wells,
be sure to place a MicroAmp® compression pad (PN 4312639) on top of the
plate to prevent evaporation during thermal cycling.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2t08°C
> 2 weeks -15t025°C

IMPORTANT! Store the amplified products so that they are protected from light.
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Amplification using bloodstained FTA® cards

Amplification using bloodstained FTA® cards

FTA® cards can be useful for collecting, storing, and processing biological samples.
A small punch disc of the card containing the sample can be placed directly into an
amplification tube, purified, and amplified, without transferring the disc. Our studies
indicate that a 1.2-mm bloodstained disc contains approximately 5 to 20 ng DNA. An
appropriate cycle number for this high quantity of DNA is 24 cycles as determined
by our validation studies. However, it is recommended that each laboratory
determine the optimum cycle number based on internal validation studies.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA card was
purified using three washes with FTA Purification Reagent and two washes with
1X low TE buffer. The purified punch disc was then amplified in the MicroAmp®
tube for 24 cycles.

24cycle-3 ‘ | | | | ‘ I™ Mark Sample for Deletion
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Figure 4 AmpF(STR® Identifiler® Plus PCR Amplification Kit results from a
1.2-mm FTA bloodstain disc (24-cycle amplification), analyzed on the Applied
Biosystems® 3130x/ Genetic Analyzer
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Electrophoresis
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Electrophoresis

This chapter covers:

B Allelic ladder requirements . . . . ..ottt 36
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Chapter 3 Electrophoresis

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples. For samples run on the:

ABI PrRISM® 310 Genetic Analyzer: Run at least one allelic ladder for every
10 sample injections.

ABI PrRisM® 3100 and Applied Biosystems® 3130 series Genetic Analyzers:
Run at least one allelic ladder per every set of 16 samples.

IMPORTANT! Variation in laboratory temperature can affect fragment
migration speed and result in sizing variation. We recommend the following
frequency of allelic ladder injections, which should account for normal variation
in run speed. However, during internal validation studies, verify the required
allelic ladder injection frequency to ensure accurate genotyping of all samples
in your laboratory environment.

— Applied Biosystems® 3130x/ or ABI PRIsM® 3100 systems — One ladder
per injection; one injection = 16 samples (15 samples + 1 allelic ladder)

— Applied Biosystems® 3130 or ABI PRISM® 3100-4vant — One ladder for
every 4 injections; one injection = 4 samples

When genotyping, it is critical to use an allelic ladder run under the same conditions
as the samples because:

Size values obtained for the same sample can differ between instrument
platforms because of different polymer matrices and electrophoretic conditions.

Variation in laboratory temperature can affect migration speed (see
IMPORTANT above).
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Section 3.1 3100/3100-Avant and 3130/3130x! instruments

Section 3.1 3100/3100-Avant and 3130/3130x/

instruments

Set up the 3100/3100-Avant or 3130/3130x/ instrument for

electrophoresis
Reagents and  Table 3 on page 18 lists the required materials not supplied with the AmpF(STR®
parts Identifiler® Plus Kit.
IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF¢STR® Identifiler® Plus Primer Set from light when not in use.
Amplified DNA, AmpF(STR® Identifiler® Plus Allelic Ladder, and GeneScan™ 500
LIZ® Size Standard should also be protected from light. Keep freeze-thaw cycles to a
minimum.
3100/3100-Avant The following table lists Data Collection Software and the run modules that can be
or 3130/3130x/ used to analyze Identifiler® Plus PCR products. For details on the procedures, refer
instrument  to the documents listed in the table.
requirements
. Data
Oge;::r':g Collection Run modules and conditions References
Y Software
Windows 3.0% ¢ HIDFragmentAnalysis36_POP4_1 Applied Biosystems® 3130/3130xI Genetic
XP (3130/3130x/ Injection conditions: Analyzers Using Data Collection Software v3.0,
Analyzer) 130 = 3 KV, Protocols for Processing AmpFI{STR PCR
- 3130 =3 kV/5 sec Amplification Kit PCR Products User Bulletin
- 3130x/ = 3 kV/10 sec (PN 4363787)
e Dye Set G5
Windows 2.0 ¢ HIDFragmentAnalysis36_POP4_1 ABI Prism® 3100/3100-Avant Genetic
2000 (3100 Injection condition: 3 kV/10 sec Analyzers Using Data Collection Software v2.0,
Analyzer) . Set G Protocols for Processing AmpFISTR PCR
Dye Set G5 Amplification Kit PCR Products User Bulletin
(PN 4350218)
Windows 1.1 ¢ GeneScan36vb_DyeSetG5Module = ABI PRISM® 3100/3100-Avant Genetic
NT® (3100 Injection condition: 3 kV/10 sec Analyzers Protocols for Processing AmpFISTR
Analyzer) . GS500Analvsi PCR Amplification Kit PCR Products User
nalysis.gsp Bulletin (PN 4332345)
1.0 ¢ GeneScan36Avb_DyeSetG5Module = ABJ PrRisM® 3100/3100-Avant Genetic
(83100-Avant Injection condition: 3 kV/5 sec Analyzers Protocols for Processing AmpFISTR
Analyzer) PCR Amplification Kit PCR Products User

e GS500Analysis.gsp

Bulletin (PN 4332345)

1 We conducted validation studies for the Identifiler® Plus Kit using this configuration.
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Section 3.1 3100/3100-Avant and 3130/3130x! instruments

Prepare samples for electrophoresis on the
3100/3100-Avant or 3130/3130x/ instrument

Prepare the Prepare the samples for electrophoresis on the 3100/3100-4vant or 3130/3130x!/
instrument immediately before loading.

. Calculate the volume of Hi-Di"™" Formamide and GeneScan"" 500 LIZ® Size

Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)
GeneScan 500 LIZ Size Standard 0.3
Hi-Di Formamide 8.7

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

. Pipette the required volumes of components into an appropriately sized

polypropylene tube.

. Vortex the tube, then centrifuge briefly.

. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

* 9 uL of the formamide:size standard mixture
* 1 uL of PCR product or allelic ladder

Note: For blank wells, add 10 uL of Hi-Di"" Formamide.

. Seal the reaction plate with appropriate septa, then briefly centrifuge the plate to

ensure that the contents of each well are collected at the bottom.

. Heat the reaction plate in a thermal cycler for 3 minutes at 95 °C.
. Immediately place the plate on ice for 3 minutes.
. Prepare the plate assembly on the autosampler.

. Start the electrophoresis run.
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Section 3.2 310 instrument

Section 3.2 310 instrument

Set up the 310 instrument for electrophoresis

Reagents and  Table 3 on page 18 lists the required materials not supplied with the AmpF/STR®
parts Identifiler® Plus Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the AmpF{STR® Identifiler® Plus Primer Set from light when not in use.
Amplified DNA, AmpF(STR® Identifiler® Plus Allelic Ladder, and GeneScan™ 500
LIZ® Size Standard should also be protected from light. Keep freeze-thaw cycles to a
minimum,.

310 instrument  The following table lists Data Collection Software and the run modules that can be
requirements used to analyze Identifiler® Plus PCR products. For details on the procedures, refer
to the documents listed in the table.

Operating Data_ "
system Collection Run modules and conditions References
Software

Windows 3.1% GS STR POP4 (1mL) G5 v2.md5 ABI PrisM® 310 Genetic Analyzer User’s Manual
xP or Injection condition: 15 kV/5 sec (Windows) (PN 4317588)
or ABI PrisM® 310 Protocols for Processing

3.0 AmpFISTR PCR Amplification Kit Products with
Windows Microsoft Windows NT Operating System: User
NT® and Bulletin (PN 4341742)
Windows
2000

1 We conducted concordance studies for the Identifiler® Plus kit using this configuration.
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Section 3.2 310 instrument

Prepare samples for electrophoresis on the 310 instrument

Prepare the Prepare the samples for capillary electrophoresis on the 310 instrument immediately
samples before loading.

1.

Calculate the volume of Hi-Di™ Formamide and GeneScan™ 500 LIZ® Internal
Size Standard needed to prepare the samples, using the table below.

Reagent Volume per reaction (uL)
GeneScan™ 500 LIZ® Size Standard 0.5
Hi-Di™ Formamide 24.5

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipette the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into a 0.2-mL or 0.5-mL sample tube, add:
* 25 pL of the formamide:size standard mixture
* 1.5 uL of PCR product or allelic ladder

Seal the tubes with the appropriate septa, then briefly vortex and centrifuge the
tubes to ensure that the contents of each tubes are mixed and collected at the
bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95 °C.

Immediately place the tubes on ice for 3 minutes.

Place the sample tray on the autosampler.

Start the electrophoresis run.
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Data Analysis
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Data Analysis
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Section 4.1 GeneMapper® ID Software

Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® ID Software

Instruments

Before you start

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each
sample in a .fsa file. Using GeneMapper® ID Software v3.2.1 software, you can then
analyze and interpret the data from the .fsa files.

Refer to “Instrument and software overview” on page 15 for a list of compatible
instruments.

When using GeneMapper® ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR® kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +0.5-nt bin window of any known allelic ladder
allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID Software for data analysis

If you are using GeneMapper® ID-X Software to perform Human Identification
(HID) analysis with AmpF{STR kits, go to “Set up GeneMapper® ID-X Software for
data analysis” on page 61 or refer to the GeneMapper® ID-X Software Version 1.0
Human Identification Analysis Getting Started Guide (PN 4375574).

Set up GeneMapper® ID Software for data analysis

Workflow Before you can analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1
for the first time:

» Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 48.

» Import an analysis method, as explained in “Import an HID analysis method”
on page S1.

» Import a size standard, as explained in “Import an HID size standard” on
page 56.

* Define custom views of analysis tables.

+ Define custom views of plots.

For more info  For details about GeneMapper® ID Software workflow and features, refer to:

»  GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide (PN 4338775)

s GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis
Tutorial (PN 4335523)

s Installation Procedures and New Features for GeneMapper® ID Software v3.2
User Bulletin (PN 4352543)
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Section 4.1 GeneMapper® ID Software

Import panels  To import the AmpF(STR® Identifiler® Plus Kit panel and bin set from our web site
and bins into the GeneMapper® ID Software v3.2.1 database:

1. Download and open the file containing panels and bins:

a. From the Support menu of www.appliedbiosystems.com, select
Software Downloads, Patches & Updates. Select
GeneMapper® ID Software v3.2 from the drop-down menu. Select
Updaters & Patches, and download the file Identifiler Plus Analysis

Files GMID.
b. Unzip the file.

2. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! If you need logon instructions, refer to page 2-7 of the
GeneMapper® ID Software Version 3.1 Human Identification Analysis User

Guide (PN 4338775).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels and bins:
a. Select Panel Manager in the navigation pane.

Fil=  Edit Bins Yiew

=1 IILE R 1

== Panel Manager

+
+
o

Highlight this

b. Select File » Import Panels to open the Import Panels dialog box.
c. Navigate to, then open the Identifiler Plus Analysis Files GMID folder
that you unzipped in step 1.
5. Select Identifiler_Plus_Panels_v1, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager, AmpFLSTR_Identifiler_Plus_v1. This folder contains the
panel and associated markers.
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CE_GS_ldentifiler _Plus_GS500:xml
Identifiler_Plus_Analysistdethod 1 ml
EI Idderitifiler_Plus_Bins _wi txd

File narme: IldentifiIer_PIus_PaneIs_v1 Lt IFpacrt |
Files of type: IA" Files ﬂ Cancel |

6. Import Identifiler_Plus_Bins_v1:

a.

Select the AmpFLSTR _Identifiler_Plus_v1 folder in the navigation
pane.

-'_;Panel Manager
File Edit Bins ‘iew

II=F><||III||=|I||BinSet| R T

=3 Panel Manager Paziel Hume Conomert
[ ampFLSTR_Panels_v2_ 1 Jdentifiler_Plus_v1 || rin
Bl AmpFLETR_ |dertifiler _Plu

Select File » Import Bin Set to open the Import Bin Set dialog box.

Navigate to, then open the Identifiler Plus Analysis Files GMID folder.

Select Identifiler_Plus_Bins_v1, then click Import.

Note: Importing this file associates the bin set with the panels in the
Identifiler_Plus_Panels_v1 folder.

CE_GS_ldentifiler _Plus_GS500 :xml
Idertifiler_Plus_AnalysisMethod_w1 ol

E] Icdertifiler _Plus_Panels w1 fxt

File narme: Ilderdifiler_Plus_Elins_w Tt Iport |
Files of type:  [al Files ~|  cancel |
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Section 4.1 GeneMapper® ID Software

7. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_Identifiler_Plus_v1 folder to view the
Identifiler_Plus_Panels_v1 folder.

b. Double-click the Identifiler_Plus_Panels_v1 folder to display the panel
information in the right pane.

[*)Panel Manager
File Edit EBEins \iew

[T 4 || Bl & (R || B | |BinSet IIdentifiIer_PIus_Bins_w L” | By W |||i|i|ili .l.l

= =IPanel Manager Mrker Mame | Dye Color | Bin iz | Bax Size | Cordrol Alleles Dilirkcer  Barkcer ¢ | Commerts Ladder Alleles
IjAmpFLSTR_PaneIS_VZ 1 [pestiva J e 1ao |[ass  |[1a 4 0.1032 [nane 8,9,1011,12,13,1
EHES ArnpFLETR |dertifier_Plus_w1 2 D151 hiue 1845 |2475 |30 4 04067 |none 2424225 26 27
= _'Eéear;i:i:e?rgplus Pangis_v1 3 |D7sa20 bue 2510 2985  [10.11 4 00969 |rone 6789101112,
I 4 |CSFIPO blue 30212 |34863 (10412 4 0.092 |nane 6,7,8,9,10,11,12,
— D7SE20 5 |Dasiasa green  |5a0 1450 1415 4 01227 |nane 12131415161
[ CSF1PO £ |THO1 green (1590 2050  |89.3 4 0.0408 |none 456,7,699351C
:?:;1358 7 \D13sHT green  |20565 (25016 |1 4 0.0993 |[nane 8,9,10,11,12,13.1
| ossmy 3 |D1G6S539 green  |2553 |30 (1112 4 0.1039 [nane 5,6,9,1011,12,13
— 55539 9 |D251338 green  |3048  |3T0H (1923 4 0.1244 |nane 15,16,17,16,19,2
[ D2s133e 10 |D195433 yellow (1010 [1480  [1415 4 01121 |none 91011121221
:ﬁfm 11w, yellow  [1510  [2135  [1716 4 0.1245 |nane 11121314151
I— 12 |TPOX yelow (21699 [26099 |8 4 0.0635 [nane 6,7,8,9,10,11,12,
— CrEss1 13 |D18351 yellow  |264.49 (3500 1519 4 01368 [nane 7,.91010.211,1%

[ AMEL 14 | AMEL v 1060 1140 |x g 00 none K
:Egism 15 |D5SE18 red 1280 1800 11 4 0.1006 |nane 7,890,123
16 |FGA red 0625 (3000|2324 4 0.1303 |nane 17,819,201 2

8. Select D8S1179 to display the Bin view for the marker in the right pane.
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(#)Panel Manager
File Edit Bins ‘iew

[ || [E W || |I||!ﬂ! | |Bin Set: ||demifi|er_P|us_Bins_v1

E-EPanel Manager
[ ampFLSTR_Panels_wz2
= ﬁ_AmpFLSTR_IdentifiIer_PIus_w
S Idertifiler_Plus_Panels

0851179
— D251
—D7saz0
—CSF1PO
— 0351358
— THI
— 135317
—1E5539
—D251338
— 185433
— s,
— TPOX
— 8551
— AMEL
— 55818
—FGA

4 |

—=JReference Samples

x|
/| | [
10 7 ] a 0 11 12 12 14 15 6 7 12 19 20
o4
05
oF
06
0s
04
0.3
oz
o1
D'?13 1149 125 131 137 143 149 1595 161 167 173 179 185
Las117a
Kl I>i
Ok | Cancel | Apply |

9. Click Apply, then OK to add the AmpF(STR® Identifiler® Plus Kit panel and
bin set to the GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels
and bins are not imported into the GeneMapper® ID Software database.

Import an HID
analysis method
page 49.

The HID Advanced analysis method for the AmpF(STR® Identifiler® Plus PCR
Amplification Kit uses the Identifiler_Plus_Bins_v1 file described in step 6 on

Use the following procedure to import the analysis method from the folder that you
downloaded from our web site, into the GeneMapper® ID Software database. Refer
to step 1 on page 48 for downloading instructions.

Note: The Identifiler_Plus_AnalysisMethod_v1 has been provided to assist you in
getting started with Identifiler Plus kit data analysis. Analysis parameters should be
established by each individual laboratory based on the laboratory's internal validation

studies.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

AmpFISTR® Identifiler® Plus User Guide
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Section 4.1 GeneMapper® ID Software

2. Import an analysis method for HID_Advanced:

a. Select the Analysis Methods tab, then click Import.

fEI'.;GeneMapper Manager il
Projects Table Settings | Plot Seftings | Matrices | Size Standards
Mare Last Saved Owyrnier Irstrurment Analysiz Type Description
HID_&dvanced 2009-06-18 16:22:2 | amicl HID =
HID_Clazszic 2007 -03-06 10:03:0 | armid HID
Microsatelite Default 2004-05-28 11:34:3 | genid Microsstelite Factary Provided =
4 I I L3 I

TEsy ... | = | SEvE BE.. | Irport... | Export... | [elete

Dane |

b. Navigate to, then open the Identifiler Plus Analysis Files GMID folder.

c. Select Identifiler_Plus_AnalysisMethod_v1, then click Import to import
the Identifiler_Plus_AnalysisMethod_v1 into the GeneMapper® ID
Software database.

[® ) Import Analysis Method x|

e

Lookin: | Identifiler Plus Analysis Files GMD = 2 2 EE

Wy Recent D...

File rame: IIdentifiler_PIus_AnaIysisMethod_w el Irigpart |
Files of type:  [uhL Files (*xm) | cancel |

To view the settings for Identifiler_Plus_AnalysisMethod_vl1, select the Analysis
Methods tab, then select Identifiler_Plus_AnalysisMethod in the Name column
and click Open.
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";GeneMapper Manager

Projects Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards |
Marne Last Saved Chner Instrument analysis Type [
| Default 2009-08-31 11:27:45.695 |gmid HID E
| Identifiler _Plus_analysisMethod_w1 2009-09-02 11:13:05,191 | gmid HID [E
4 I I L3 I
Mew, . | CIEE, | Save fs.., | Impart. .. | Expart, .. | Delete
Dane %
=}
@
<
)
Figure 5 Analysis Method Editor - HID: General tab settings g
Figures 6 through 9 below show the settings for each tab of the Analysis Method 8
Editor - HID. 2
=
)
o
Analysis Method Editor - HID x|
General  Allele | Peak Deteu:tu:url Peak Qual'rtyl Gty Flagsl
Bin Set: Idertifiler_Plus_Bins_w
W Lze marker-specific stutter ratio it available
Marker Repest Type Tri Tetra Perta Hexa
Cut-off Walue 0.0 0.0 0.0 0.0
Minus4, Ratio 0.0 0.0 0.0 0.0
Minus, Distance From |0.0 0.0 0.0 0.0
To |00 0.0 0.0 0.0
Minus Stutter Ratio 0.0 0.0 0.0 0.0
Minus Stutter Distance  From |00 f3.25 0.0 0.0
To |00 fa.75 0.0 0.0
Plus Stutter Ratio 0.0 0.0 0.0 0.0
Plus Stutter Distance  From |00 0.0 0.0 0.0
To |00 0.0 0.0 0.0
Atmelogenin Cutoff ||:|_|:|
Range Fitter ... | Factory Defaults
8],1 Cancel

Figure 6 Analysis Method Editor - HID: Allele tab settings

 GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

AmpFISTR® Identifiler® Plus User Guide 53



Section 4.1 GeneMapper® ID Software

The “Use marker-specific stutter ratio if available” check box is selected by

default. Consequently, the software applies the stutter ratio filters supplied in

the Identifiler_Plus_Panels_v1 file.

For more information about allele filters, refer to:

GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide, Chapter 3 (PN 4338775)

GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis
Tutorial (PN 4335523)

Installation Procedures and New Features for GeneMapper® ID Software v3.2
User Bulletin (PN 4352543)

Analysis Method Editor - HID x|

General | Allele  Pesk Detector | peak cuaity | Guality Flags |

Peak Detection Algotithen: IAdvanced LI
~Ranges ~Peak Detection
Arialhysis =izing Peak Amplitude Thresholds:
Full Range LI IAII Sizes LI B: ISIII R ISIII
=tart P |0 Start Size 7S
Stop PE 10000 Stop Size: [450 G: ISD O: ISD
mp P op Size:
LE ISD
—=moothing and Bazelining
Wi, Peak Half icth: |2 pts
Stmoothir " Mone I—
. : o
o Light Palynarmial Degree:
" Heawy Peak Window Size: 11 pt=
Bazeling Window: |51 pts =lope Threshald
Peak Start: I':'-':'
—=ize Calling Method Peak Enc: IIZI.IZI
" 2nd Order Lesst Souares
" 3rd Order Least Souares
= Cubic Spline Interpolation
&+ Local Southern Method
" Glokal Southern Method
Factory Defaults |

(034 | Cancel |

Figure 7 Analysis Method Editor - HID: Peak Detector tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the peak amplitude thresholds that allow for reliable
interpretation of AmpF(STR® Identifiler® Plus PCR Amplification Kit data.
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The software uses the peak amplitude threshold parameters to specify the minimum
peak height to limit the number of detected peaks. Although GeneMapper® ID
Software displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or determine the genotype of these
peaks.

Note: The analysis range is set by the user based on the locations of the primer peaks
and size standard peaks.

For more information about peak detection algorithms, refer to:

»  GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide (PN 4338775)

s GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis
Tutorial, Appendix A (PN 4335523)

s Installation Procedures and New Features for GeneMapper® ID Software v3.2
User Bulletin (PN 4352543)

Analysis Method Editor - HID x|

General | Allele | Peak Detector Pk Qualty | qusity Flags |

)
[v]

>

[v]

=
Q
o
iel

(0]

=

)
(7]
o

=0
=

Q

=

o

~Sigral level

Haomazygous min peak height |1 oo.o
Heterozygous min peak height ISD.D

~Heterozygote balance
in pesk height ratio IIZI.T-r
Peak morphology

Max peak width (hasepairs) |1 A

rPull-up peak

Puill-uigy ratio 0.05

~allele number

Max expected alleles |2

Factory Defaults |

Ok | Cancel |

Figure 8 Analysis Method Editor - HID: Peak Quality tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the minimum heterozygous and homozygous minimum peak
height thresholds and the minimum peak height ratio threshold that allow for reliable
interpretation of AmpF(STR® Identifiler® Plus PCR Amplification Kit data.
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Analysis Method Editor - HID

General | Allele | Peak Detector | Peak qualty Guslty Flags |

Guality weights are between 0 and 1.

—Guality Flag Settings
Spectral Pull-up ID_B Contral Concordance |1 o
Eroad Peak ID.B Low Peak Height ID 3
Out of Bin Allele |D.8 Off-scale |U G
Overlap Ig_g Peak Height Ratio ID.3
rPE Threshalds
Pass Range: Lowe Quality Range:
Sizing Guality: From IEI.?S to1.0 Frotm 00to  [0.25
Genatype Qualty: From |0.735 ta10 FromioOto  [0.25

Factory Defautts |

QK Cancel |

Figure 9 Analysis Method Editor - HID: Quality Flags tab settings

Import an HID
size standard

The size standard for the Identifiler® Plus Kit uses the following GS500 peaks in its
sizing algorithm: 75, 100, 139, 150, 160, 200, 300, 350, 400, and 450.

Use the following procedure to import the size standard for the AmpF(STR®
Identifiler® Plus PCR Amplification Kit from the folder that you downloaded from
our web site, into the GeneMapper® ID Software database. Refer to step 1 on

page 48 for downloading instructions.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

2. Import a size standard:

a. Select the Size Standards tab, then click Import.

IE;!GeneMapper Manager

Projects | Analysis Methiods | Table Settings | Piot Setings | Matrices |5

|Name |Last Sawved |Owner Type |Descripti0n
SF7_F_HD_G=s500 2004-05-28 11:34:3 gmid BasiciAdvanced Factory Provided [+
CE_G5_HID_G=500 2004-05-25 11:34:3 grmic Basiciddvanced Factary Provided
CE_F_HID_GS500 2004-05-25 11:34:3 gmid Easiciidwvanced Factory Provided |
e ERen... Save Lz Irppart... Export... [elete |
Done |

b. Navigate to, then open the Identifiler Plus Analysis Files GMID folder.
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c. Select CE_G5_Identifiler_Plus_GS500, then click Import to import the
CE_G5_Identifiler Plus_GS500 size standard into the GeneMapper® ID
Software database.

f_?_:lmport Size Standard Method ll

2 (O =

Look in: I&] Identifiler Plus Analysis Files GMID

Identifiler_Plus_analysishethod_w1 xml

File name: ICE_GS_Identifiler_PIus_GSSDD.me Import |
LI Cancel |

)
[v]
>
[v]
=
Q
O
O
@
=
)
(7]
o
=0
=
Q
=
()

Files oftype: [« Files (*.xm)

Analyze and edit sample files with GeneMapper® ID
Software

Analyze a project 1. In the Project window, select File » Add Samples to Project, then navigate to

the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings

Sample Type

Select the sample type.

Analysis Method

Identifiler_Plus_AnalysisMethod_v1

Panel

Identifiler_Plus_Panels_v1

Size Standard*

CE_G5_ldentifiler_Plus_GS5008#

$ For more information about how the Size Caller works, refer to the ABI Prism® GeneScan®
Analysis Software for the Windows NT® Operating System Overview of the Analysis Parameters
and Size Caller User Bulletin (PN 4335617).

§ The following fragments are defined for the CE_G5_lIdentifiler_Plus_GS500 size standard
provided with the AmpF{STR® Identifiler® Plus Kit: 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (PN 4338775), Appendix D.

# Neither the 250-nt nor the 340-nt peak are included in the size standard definition. These peaks
can be used as an indicator of precision within a run.

3. Click (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

» The status bar displays the progress of analysis:
— Asa completion bar extending to the right with the percentage
completed indicated

— With text messages on the left
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* The Samples table (figure below) displays the row of the sample currently

being analyzed in green (or red if analysis failed for the sample).

» The Genotypes tab becomes available after analysis.

2.1 - *Untitled - gmid Is Logged In
ew Tools Help

5 | | TN | | £l | | [ ] | |Table Seﬂing:| |IHID_LadderTabIe_FiIeName LI = | | B & | | B»
Samples | Genotypes I
Status | Sample File Sarmple Mame Sample Type | Analysis Method Panel Size Standard Instrument Type

1 h Cerebus_3130XL |IB_0329 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
2 h Cerebus_3130%L |IB_0330 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
3 h Cerebus_3130%L |IB_0331 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
4 h Cerebus_3130XL |IB_0332 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
5 h Cerebus_3130XL |IB_0333 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
B h Cerebus_3130XL |IB_0334 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
7 h Cerebus_3130%L |IB_0335 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
g h Cerebus_3130%L |IB_0336 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
9 h Cerebus_3130%L |IB_0337 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
10 h Cerebus_3130XL |IB_0338 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
ih! h Cerebus_3130XL |IB_0339 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
12 h Cerebus_3130XL |IE_0340 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
13 h Cerebus_3130%L |IE_0341 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
14 h Cerebus_3130XL |IB_0342 Sample Idertifiler_Plus_Analysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130
15 h Cerebus_3130XL |ladder3 Allelic Ladder | Idertifiler_Plus_&nalysishethod_w1 Identifiler_Plus_Panelz_v1  |CE_GS_ldentifiler_Plus_GS500  |ABI3130

For more information about any of these tasks, refer to the GeneMapper® ID
Software Version 3.1 Human Identification Analysis User Guide (PN 4338775).

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information about any of these tasks, refer to:

GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis

Tutorial (PN 4335523)
GeneMapper® ID Software Version 3.1 Human Identification Analysis User
Guide (PN 4338775)

Installation Procedures and New Features for GeneMapper® ID Software
Version v3.2 User Bulletin (PN 4352543)
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Section 4.2 GeneMapper® ID-X Software

Overview of GeneMapper® ID-X Software

Instruments

Before you start

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each
sample in a .fsa file. Using GeneMapper® ID-X Software v1.0.1, v1.1, or v1.1.1, you
can then analyze and interpret the data from the .fsa files.

Refer to “Instrument and software overview” on page 15 for a list of compatible
instruments.

When using GeneMapper® ID-X Software v1.0.1, v1.1, or v1.1.1 to perform human
identification (HID) analysis with AmpF¢STR® kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Your
laboratory can use multiple ladder samples in an analysis, provided individual
laboratories conduct the appropriate validation studies.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a
run folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the AmpF¢STR® Allelic Ladders do exist. Off-ladder
(OL) alleles may contain full and/or partial repeat units. An off-ladder allele is
an allele that occurs outside the +0.5-nt bin window of any known allelic ladder
allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the sample result
needs to be verified according to the laboratory’s protocol.
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Set up GeneMapper® ID-X Software for data analysis

Workflow Before you can analyze sample (.fsa) files using GeneMapper® ID-X Software
v1.0.1, v1.1, or v1.1.1 for the first time:

» Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” on page 61.

» Import an analysis method, as explained in “Import an analysis method” on
page 66.

» Import a size standard, as explained in “Import a HID size standard” on
page 71.

* Define custom views of analysis tables.

* Define custom views of plots.

For more info  For quick set up instructions, refer to the GeneMapper® ID-X Software Version 1.0
Getting Started Guide (PN 4375574).

For details about the GeneMapper® ID-X Software workflow and features, refer to:

» GeneMapper® ID-X Software Version 1.0 Getting Started Guide (PN 4375574)
+  GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (PN 4375670)
+ GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)

Import  To import the AmpF{STR® Identifiler® Plus Kit panels, bin sets, and marker stutter
panels, bins, and  from our web site into the GeneMapper® ID-X Software v1.0.1, v1.1, or v1.1.1
marker stutter database:

1. Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.appliedbiosystems.com, select
Software Downloads, Patches & Updates. Select
GeneMapper® ID-X Software from the drop-down menu. Select
Updaters & Patches, and download the file Identifiler Plus Analysis
Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! If you need logon instructions, refer to the GeneMapper® ID-X
Software Version 1.0 Getting Started Guide (PN 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.
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Section 4.2 GeneMapper® ID-X Software

g* Panel Manager

File Edit Eins Miew Help

OX | WfEm| | m

Highlight this.
|

=

b. Select File » Import Panels to open the Import Panels dialog box.
c. Navigate to, then open the Identifiler Plus Analysis Files GMIDX folder
that you unzipped in step 1 on page 61.
5. Select Identifiler_Plus_Panels_v1X, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager “AmpFLSTR_Identifiler_Plus_v1X.” This folder contains the
panel and associated markers.

p* Import Panels x|

Look i I&] Idertifiler Plus Analysis Files GMIDE LI I o ==

CE_GS_Identifiler_Plus_a5500, xml
[Z] 1dentifier_Plus_Bins_v1¥.txt

B Identifier_Plus_Panels_w1x.kxk
E] Identifier_Plus_Skutter_w1x.bxt
Identifiler_Plus_analysistethod_w 1, xml

File narme: |Identifier_PIus_PaneIs_v1X.txt Import |
Files of bype: IAII Files ;I Cancel |

6. Import Identifiler_Plus_Bins_v1X:

a. Select the AmpFLSTR_Identifiler_Plus_v1X folder in the navigation
pane.

gt Panel Manager

File Edit Bins Wiew Help

X | B WO | W™ | ense] =1
B r_.,.%p_,PaneI Manager Panel Hame Commmert
s D AMPFLS TR _Panels_v 13 1 fidentifiler_Plus_Panels_v1x |null

e (i AmpFLSTR_Identifiler _Plus_w1%

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AmpFLSTR_Identifiler_Plus_v1X folder.
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d. Select Identifiler_Plus_Bins_v1X, then click Import.

Note: Importing this file associates the bin set with the panels in the
Identifiler_Plus_Panels_v1X folder.

o* Import Bin Set
Look in: IEJ Identifiler Plus Analysis Files GMIDK LI _I '__E

CE_GS5_Identifiler_Plus_G5500,xml

8 Identifier_Plus_Fin k

[£] 1dentifier_Plus_Panels_vi¥.kxt

r_'é] Identifier_Plus_Skutkber_w1x.txk
Identifiler _Plus_analysisMethod_v 1%, xml

7. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_Identifiler_Plus_v1X folder to view the
Identifiler_Plus_Panel v1X folder.

b. Double-click the Identifiler_Plus_Panel_v1X folder to display the panel

information in the right pane and the markers below it.

o* Panel Manager

File Edit Bins Wiew Help

i X | E ® o\ | @ |Bin5et: IIdentiFiIer_PIus_Bins_v1>< ~] | [ = ||.|.|.|.
= &Panel Manager - Dlarcer Harme Dne Color | BEin Size  |BBax Sime | Coirol Alleles | Mladeer |Commerds |Ladder Alleles
(- [ AmpFLSTR_Panels_v1¥ 1 psirs Bue  |118.0 |1835 |13 4 nore  |,9,10,11,12,13,14,15,1
- L AmpFLSTR Identfiler_Plus_vix 2 |D21sil Blue 1845 2475 |30 4 none  |24,24.2,25, 26,27, 28,28,
S O [donrer Pl Pa i 3 |D7saz0 Blue 2510|2985 [10,11 4 none  |6,7,8,5,10,11,12,13,14,
4 |CSFIPO Blue  |302.12 |348.63 |10,12 4 nore  |6,7,8,9,10,11,12,13,14,
5 |D351358 Green (980 (1480  |14,15 4 nore  |12,13,14,15,16,17,18,1¢
& |THOL Gresn  |159.0 2050 |8,9.3 4 nore  |4,5,6,7,8,5,9.3,10,11, 11
7 |D135317 Green  |205.65 (250,16 |11 4 nore  |8,9,10,11,12,13,14,15
8 |Dl65539 Green  |255.3  |30LA1 |11,12 4 nore  |5,8,9,10,11,12,13,14,15
3 |D251338 Green  |304.8 (370,31 |19,23 4 nore  |15,16,17,18,19,20,21,2
10 |D195433 vellow  |101.0 (1480  |14,15 4 nore  |9,10,11,12,12.2,13,13.2
11 v vellow  |151.0 (2135  |17,18 4 nome  |11,12,13,14,15,16,17, 11
12 [TPOX vellow  |216.99 |260.99 |8 4 nore  |6,7,8,9,10,11,12,13
13 |D18s51 vellow  |264.49 |350.0  |15,19 4 nore  |7,9,10,10.2,11,12,13,1%
14 |AMEL Red 1060 [1140 | E nore %Y
15 |D55818 Red 1280 |180.0 |11 4 nore  |7,8,9,10,11,12,13,14,15
16 |Faa Red  |206.25 (3600|2324 4 nore  |17,18,19,20,21,22,23,2

8. Select D2S1388 to display the Bin view for the marker in the right pane.
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#* Panel Manager x|

File Edit Bins Wiew Help

B0 | @ BB | Bl | Binsets [identiier_Plus_Bins_v1x

e ERE IEEEEE| e

- fPanel Manager 7 s al ol 1) [zl 1z 4l s el 170 18l 18] =
- ICAMPFLSTR_Panels_v1¥ 1)
E|---E_)AmpFLSTR_IdentiFiIer_PIus_v1><

B2 Identifiler_Plus_Panels_v 13
= na
21511
- D75820 0s
- CSFIPC
- 351358
-~ THO1 o7
- 135317
- 165539
- D251338 &
- 195433
- WA 05
- TP
- 18551
-~ AMEL 0.4
+- 055818
[ Fizh
0z
0z
------ B Reference Samples
041
0o
1195 117 119121 123125 127 123131 133135 137 129141 143145 147143 151 153155 157159 161 163165 167169 171173175 177473 131183185 187
bE51178
Kl
Marker: D851179 (118.00-183.50)

OF | Cancel | Apply | Help |

9. Import Identifiler_Plus_Stutter_v1X:

a. Select the AmpFLSTR_Identifiler_Plus_v1X folder in the navigation

panel.

p* Panel Manager

File Edit Bins Yiew Help

i > | WM W | W= | Binset: [dentifiler_Plus_Bins_vix

=]

Darel Harme

(] g, Panel Manager

Cloprirvert

dentifiler _Plus_Panels_w1x

rull

[T AmMpFLSTR_Panels_w1x 1
f&i 2mpFLSTR_Identifiler_Plus_w1%

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

c. Navigate to, then open the Identifiler Plus Analysis Files GMIDX folder.

d. Select Identifiler_Plus_Stutter_v1X, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set

in the Identifiler_Plus_Bins_v1X folder.
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p* Import Marker Stutter 1'

Lok i I[E] Idenkifiler Plus Analysis Files GMIDK LI _I EE

CE_GS_Identifiler_Plus_G5500.xml
[Z] 1dentifier_Plus_Bins_vi¥.kxt

[Z] 1dentifier_Plus_Panels_v1s.kxt
@ Identifier_Plus_stutter
EI Identifiler _Plus_analysisMethod_sw 1%, xml

File name:; IIdentiFier_F‘Ius_Stutter_vIx.txt Impart: |
Files of kype: Ip.” Files ;I Cancel |

10. View the imported marker stutters in the navigation pane:

a. Select the Identifiler_Plus_Panel_v1X folder to display its list of markers
in the right pane.

b. Double-click the Identifiler_Plus_Panel_v1X folder to display its list of
markers below it.

c. Double-click D5S818 to display the Stutter Ratio & Distance view for the
marker in the right pane.

#* Panel Manager

File Edit Bins Wiew Help

al X | B ® | |H |BinSet: IIdentifiler_PIus_Bins_vl>< LI | AN N ||.|.|.|. o M| | @
- afPanel Manager = Please enter the stutter filter(s) for D5S818 marker hera If left blank, the global stutter filter will be applied.
- [CAMPFLSTR_Panels_v1¥
E---E)AmpFLSTR_IdentiFiIer_PIus_v1>< q
I:E|---E_)IdentiFiIer_PIus_PaneIs_v1>< Minus Stutter Plus Stutter
D251338 R.atio From Distance Tao Distance R.atio From Distance Tao Distance
1 1006 3.25 4.75 1
2 2
3 3
4 4
Tew | Edit | Delete |

- Da51179

11. Click Apply, then OK to add the AmpF(STR® Identifiler® Plus Kit panels, bin
sets, and marker stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper®
ID-X Software database.
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Import an  Use the following procedure to import the analysis method for the AmpF{STR®
analysis method Identifiler® Plus PCR Amplification Kit from the folder that you downloaded from
our web site, into the GeneMapper® ID-X Software database. Refer to step 1 on
page 61 for downloading instructions.

Note: The Identifiler_Plus_AnalysisMethod_v1x has been provided to assist you in
getting started with Identifiler Plus kit data analysis. Analysis parameters should be

established by each individual laboratory based on the laboratory's internal validation
studies.

1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper ID-X Manager.

2. Import an analysis method:

a. Select the Analysis Methods tab, then click Import.

o GeneMapper® ID-X Manager 1[

Find Mame Containing: I

Projects  Analysis Methods | Table Settingsl Plot Settingsl Matrices | Size Standards | Report Settings
Marme Last Saved Chner Instrument Analysis Type Descripkion
| AMpFLSTR. Analysis Method 2007-12-18 16:18:2 | gmids HID H
0| I ;l

Mew, ., | DEE Save A5, Imnpork. .. Expork, .. Delete |
Help | Done |

b. Navigate to, then open the Identifiler Plus Analysis Files GMIDX folder.

c. Select Identifiler_Plus_AnalysisMethod_v1X, then click Import to
import Identifiler_Plus_AnalysisMethod_v1X into the GeneMapper® ID-X
Software database.

gt Import Analysis Method x|
Look in: I&J Identifiler Plus Analysis Files GMIDS LI I = B =

CE_G5_Identifiler_Phs_G5500,xml
| Identifiler_Plus_anakysisMethod_v1x,xml

&I

My Recent
Dacuments

m.

Deskio B

My IZ:S:EJrnent:: File: narne: IIdentiFiler_PIus_AnaIysisMethod_vIx.xml Irnpork |
Iﬁ_I Files of bype: IXML Files (* xml) LI Cancel |

3. To view the settings for Identifiler_Plus_AnalysisMethod_v1X, select the
Analysis Methods tab, then select Identifiler_Plus_AnalysisMethod_v1X in
the Name column and click Open.
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o GeneMapper® ID-X Manager ﬂ

Find Mame Containing: I

Frojects Analysis Methods | Table Settingsl Plok Settingsl Matricesl Size: Standardsl Report Settingsl

Marne Lask Sawed Owner Inskrurnent Analysis Type [
| Default 2009-03-31 11:27:45.695 |gmid:x HID
| Identifiler_Plus_analysisMethod_v1¥ 2009-09-02 11:13:05,191  |gmid: HID

Mew, ., | L6u = | Save Bs.., | Impart... | Export,.. | Delete |

Help | Dane |

Figure 10 Analysis Method Editor: General tab settings

Figures 11 through 14 below show the settings for each tab of the Analysis Method
Editor.
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Analysis Method Editor x|
General  Allele I Peak Detectaor | Peak Quality | a0} & G0 Settings |
Bin Set; Identifiler_Plus_Bins_s1%
[+ Use marker-specific stutker ratio and distance if available
Marker Repeat Type: Tri Tekra Penta Hexa
Global Cut-off Valus ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
Mirusé Ratio ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
Minusa Distance From ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
To ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
Global Minus Stutter Ratio ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
Global Minus Stutter Distance  From ||:|.|:| |3.25 ||:|.|:| ||:|.|:|
To ||:|.|:| |4.?5 ||:|.|:| ||:|.|:|
Global Plus Stutter Ratio ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
Global Plus Stutter Distance  From ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
To ||:|.|:| ||:|.|:| ||:|.|:| ||:|.|:|
amelogenin Cukaff IIII.III
Range Filter. .. | Fackory Defaults |
Save Zancel | Help |

Figure 11 Analysis Method Editor: Allele tab settings

+ GeneMapper® ID-X Software 1.0.1, 1.1, or 1.1.1 allows you to specify four
types of marker repeat motifs: tri, tetra, penta, and hexa. You can enter
parameter values for each type of repeat in the appropriate column.

» The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied in
the Identifiler_Plus_Stutter_v1X file.

For more information about allele filters, refer to:
» GeneMapper® ID-X Software Version 1.0 Getting Started Guide (PN 4375574)

+ GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (PN 4375670)
+ GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)
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Analysis Method Editor x|

Peak Detection Algorithm: Advanced

~Ranges ~Peak Detection
Analysis Sizing Peak Amplitude Threshalds:
Full Range LI I.ﬁ.ll Sizes LI B: ISIII R: ISEI
Stark: PR {1000 Statk Sizedd
— o G: 50 0: |50
Stop PE: 10000 Stop Sizesn (1000
L' ISEI
—3moothing and Baselining
Min. Peak Half 'Width: |2 pts
amookhing i Mane
i : 3
oL Polynomial Degree I
" Heawy Peak Window Size: |15 pts
Baseline Window: |51 pts Slape Threshold
Peal, Start: IIII.III
—3ize Calling Method Peak End: IF

" 2nd Order Least Squares
£~ 3rd Crder Least Squares
" Cubic Spline Interpolation
¥ Local Southern Method
™ Global Southern Method

Fackory Defaults |

Save As | Save | Zancel | Help |

Figure 12 Analysis Method Editor: Peak Detector tab settings

The software uses the peak amplitude threshold parameters to specify the minimum
peak height to limit the number of detected peaks. Although GeneMapper® ID-X
Software displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or determine the genotype of these
peaks.

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the peak amplitude thresholds that allow for reliable
interpretation of AmpF(STR® Identifiler® Plus PCR Amplification Kit data.

For more information about peak detection algorithms, refer to:
+ GeneMapper® ID-X Software Version 1.0 Getting Started Guide (PN 4375574)
+ GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (PN 4375670)
+ GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)
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Analysis Method Editor x|

General | Allele | Peak Detectar Peak Quality | 50 & GQ Settings |

~MinfMax Peak Height (LPH/MPH)

Homozygous min peak height 100.0

Heterozygous min peak height

ENE

Mazx Peak Height (MPH) 3000.0

~Peak Height Ratio (PHR)

Min peak height ratio 0.7
~Broad Peak (B

Max peak width (basepairs) |1 5

—allele Mumber (AR}

T

Max expected alleles

—allelic Ladder Spike

c

Zuk-off Yalue 0.z

Fackory Defaults

Save As | Save | Zancel | Help |

Figure 13 Analysis Method Editor: Peak Quality tab settings

IMPORTANT! Laboratories need to perform the appropriate internal validation
studies to determine the minimum heterozygous and homozygous minimum peak
height thresholds and the minimum peak height ratio threshold that allow for reliable
interpretation of AmpF(STR® Identifiler® Plus PCR Amplification Kit data.
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Analysis Method Editor |

General | Allele | Peak Detector | Peak Qualicy 5Q & GQ Settings |

Quality weights are between 0 and 1.
~3ample and Contral GO Weighting

Allele Mumber (AR

Low Peak Height (LPH)
Max Peak Height (MPH)
Off-scale (090

Peak Height R.atio (PHR)

Broad Peak (BD)

Cut of Bin &llele (BIN)
Crverlap (OWL)
Marker spike (SPE)

EEER
EREER

Control Concordance (C0C) Weight = 1.0 {Cnly applicable ko controls)

—30) Weighting
Broad Peak (BD) 5

~allelic Ladder GO Weighting

IEI
Spike (SSPEISPED |1 VI Off-scale {035}

50 & G Ranges

1

Sizing Quality: Fram ID.?S ko 1.0 From 0.0 o ID 25
Genotype Quality:  From II:I.F"S ko 1.0 From 0.0Eo ID.ZS

Reset Defaults |

Save bs | Save | Cancel | Help |

Figure 14 Analysis Method Editor: SQ and GQ tab settings

Import a HID size  The size standard for the AmpF(STR® Identifiler® Plus PCR Amplification Kit uses
standard the following GeneScan 500 LIZ size standard peaks in its sizing algorithm: 75, 100,
139, 150, 160, 200, 300, 350, 400, and 450.

Use the following procedure to import the size standard for the AmpF(STR®
Identifiler® Plus PCR Amplification Kit from the folder that you downloaded from
our web site, into the GeneMapper® ID-X Software database. Refer to step 1 on
page 61 for downloading instructions.
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1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X
Manager.
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2. Import a size standard:

a. Select the Size Standards tab, then click Import.

w GeneMapper® ID-X Manager 5'
Find Mame Conkaining: I
Projects | Analysis Methods' Tahle Settingsl Plat Settingsl Matrices  Size Standards | Repork Settingsl
MNarne Last Saved Qwner Type Descripion
CE_F_HID_G5500 (75-400) |2007-03-09 13:23:5 gmid:x Advanced -
CE_F_HID_GS500 (75-450) [2007-08-09 13:24:0 | gmid: Advanced
CE_5_HID_G5500 2006-10-11 13:12:% | grnids advanced -
Mew. ., e, Saveis,, . Import,. Expork... De|ete |
Help | Done |

b. Navigate to, then open the Identifiler Plus Analysis Files GMIDX folder.

c. Select CE_G5_Identifiler_Plus_GS500, then click Import to import the
CE_G5_Identifiler_Plus_GS500 analysis method into the GeneMapper®
ID-X Software database.

w* Import Size Standard Method x|
Lack in: I[ﬁ) Identifiler Flus Analysis Files GMIDH LI _I = B

Identifiler _Plus_aAnalysisMethod_v 1%, xml

File name:; ICE_GS_Identifiler_F‘Ius_GSSUD.xml Impart: |
Files of kype: IXML Files (*,xmi) ;I Cancel |
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Analyze and edit sample files with GeneMapper® ID-X
Software

Analyze a project 1. Inthe Project window, select File » Add Samples to Project, then navigate to
the disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Identifiler_Plus_AnalysisMethod_v1X
Panel Identifiler_Plus_Panel_v1X
Size Standard* CE_G5_Identifiler_Plus_GS500%*

t For more information about how the Size Caller works, refer to the ABI PrismM® GeneScan®
Analysis Software for the Windows NT® Operating System Overview of the Analysis Parameters
and Size Caller User Bulletin (PN 4335617).

§ The following fragments are defined for the CE_G5_Identifiler_Plus_GS500 size standard
provided with the AmpF{STR® Identifiler® Plus Kit: 75, 100, 139, 150, 160, 200, 300, 350, 400,
and 450. For additional information about size standards, refer to the GeneMapper® ID Software
Version 3.1 Human Identification Analysis User Guide (PN 4338775), Appendix D.

# Neither the 250-nt nor the 340-nt peak are included in the size standard definition. These peaks
can be used as an indicator of precision within a run.

3. Click » (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

» The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Analysis Summary tab (see figure on next page) is displayed upon
completion of the analysis.
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p* GeneMapper® ID-X - 09-02-09 Dickens Analysis Method Example - gmidx Is Logged In Database FOSWANGD1LDS
File Edit Analysis View Tools Admin Help

CONH | W | mEE W | b @ | Tablesetting: | [31x:Data Analysis la | rel| 2 e
E---%Project : Samples Analysis Summary I Genotypesl

- IC2) Identifiler Flus Analysis Examples

Analysis Summary

Select run Folder ko display: IIdentiFiIer Flus Analysis Examples LI
Sample Status Total # of Samples
E Unanalyzed o
Analyzed 39
L)j Analysis Setting Changed o
Click a link below to dizplay a filtered Samples Table containing only the samples selected.
Allelic Ladder Quality per run folder {based on S0 and CGQ only)
Run Folder Total # of Analyzed Ladders & o
Identifiler Plus Analysis Examples 3 3 o o
Control Quality per project (based on sample POVs: S05, S5PK, MIX, OMR, 50, CGQ)
Control Type Total # of Samples All threshalds met o One or more thresholds not met
Positive Control 3 3 o
Custorn Contraol 1] 1] 1]
Megative Control 4 4 o
Tatal 7 7 o
Sample Quality per project (based on sample PQYs: S0S, SSPK, MIX, OMR, 50, CGQO)
Total # of Samples Al thresholds met: o One or more threshalds not met:
Samples 29 17 1z

4 |

Analysis Completed, |

For more information about any of these tasks, refer to:
» GeneMapper® ID-X Software Version 1.0 Getting Started Guide (PN 4375574)

+  GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (PN 4375670)
» GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information about any of these tasks, refer to:

s GeneMapper® ID-X Software Version 1.0 Getting Started Guide (PN 4375574)
s GeneMapper® ID-X Software Version 1.0 Quick Reference Guide (PN 4375670)
»  GeneMapper® ID-X Software Version 1.0 Reference Guide (PN 4375671)
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Chapter 5 Experiments and Results

Overview

Experiments
using the
AmpF(STR®
Identifiler® Plus
Kit

Importance of
validation

Experiment
conditions

This chapter provides results of the developmental validation experiments performed
using the AmpF(STR® Identifiler® Plus PCR Amplification Kit.

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics.
By challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations
which are critical for sound data interpretation in casework (Sparkes, Kimpton,
Watson et al., 1996; Sparkes, Kimpton, Gilbard et al., 1996, and Wallin ef al., 1998).

Experiments to evaluate the performance of the AmpF(STR® Identifiler® Plus PCR
Amplification Kit were performed. The experiments were performed according to
the DNA Advisory Board (DAB) Quality Assurance Standards, effective October 1,
1998 (DNA Advisory Board, 1998). The DAB standards describe the quality
assurance requirements that a laboratory should follow to ensure the quality and
integrity of the data and competency of the laboratory.

Additional validation was performed according to the revised guidelines from the
Scientific Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003).
Based on these guidelines, we conducted experiments that comply with guidelines
1.0 and 2.0 and its associated subsections. This DNA methodology is not novel.
(Moretti et al., 2001, Frank et al., 2001, Wallin et al., 2002, and Holt et al., 2000).

This chapter discusses many of the experiments performed by us and provides
examples of results obtained. We chose conditions that produced optimum PCR
product yield and that met reproducible performance standards. While these
experiments are not exhaustive, they are appropriate for a manufacturer of STR kits
intended for forensic and/or parentage testing use.

IMPORTANT! Each laboratory using the AmpF(STR® Identifiler® Plus PCR
Amplification Kit must perform internal validation studies.
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Developmental validation

SWGDAM  “Developmental validation is the demonstration of the accuracy, precision, and
guideline 1.2.1  reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

SWGDAM  “The reaction conditions needed to provide the required degree of specificity and
guideline 2.10.1  robustness must be determined. These include thermal cycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical
reagents.” (SWGDAM, July 2003)

PCR components We examined the concentration of each component of the AmpF(STR® Identifiler®
Plus PCR Amplification Kit. The concentration for each individual component was
established to be in the window that meets the reproducible performance
characteristics of specificity and sensitivity. For example, various magnesium
chloride concentrations were tested on the Applied Biosystems® 3130x/ Genetic
Analyzer. The amplification of 1.0 ng of the Control DNA 9947A for 28-cycles is
shown in Figure 15. We observed that the performance of the multiplex is robust
within a £30% window of the optimum magnesium chloride concentration.

% Change

+30%
.

20%

+ 0
.

ULl

J Wl 0%
L] MJ W o

-20%

Gl b

-30%

Figure 15 1.0 ng of Control DNA 9947A amplified with the AmpF(STR®
Identifiler® Plus Kit for 28-cycles in the presence of varying concentrations of
magnesium chloride and analyzed on the Applied Biosystems® 3130x/ Genetic
Analyzer
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Thermal cycler

parameters

Thermal cycling parameters were established for amplification of the AmpF{STR®
Identifiler® Plus PCR Amplification Kit. Thermal cycling times and temperatures of
GeneAmp® PCR systems were verified. Varying annealing/extension and
denaturation temperature windows were tested to verify that a specific PCR product
with the desired sensitivity of at least 1.0 ng of AmpF{STR Control DNA 9947A was
produced.

For example, annealing/extension temperatures were tested at 55, 57, 59, 61, and

63 °C for 3-minute hold times in the Silver 96-Well GeneAmp® PCR System 9700
(Figure 16). The PCR products were analyzed using the Applied Biosystems® 3130x/
Genetic Analyzer.

Of the tested annealing/extension temperatures, 55 to 61 °C produced robust
profiles. At 63 °C the yield of the majority of loci was significantly reduced. Routine
thermal cycler calibration is recommended when you follow the amplification
protocol. No preferential amplification was observed at the standard
annealing/extension temperature of 59 °C.

155 135 235 275 315 355 395

T
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155 135 235 275 315 355 395

57 °C
| lhh.ll N “u oot

115

155 135 235 275 355 395

75

61 °C
_ [ .ll W .hu il d

75

115

59 °C
Ll ll bil l .hn dl 4 i

155 195 235 275 355 395

115

155 135 235 275 315 355 395

I e |

63 °C

PCR cycle
number

Figure 16 Electropherograms obtained from amplification of 1.0 ng of Control
DNA 9947A at annealing/extension temperatures of 55 °C, 57 °C, 59 °C, 61 °C,
and 63 °C, analyzed on the Applied Biosystems® 3130x/ Genetic Analyzer, Y-axis
scale (0 to 4,000 RFUs)

AmpF(STR® Identifiler® Plus PCR Amplification Kit reactions were amplified for
26,27, 28, 29, and 30 cycles on the Silver 96-Well GeneAmp® PCR System 9700
using 1.0 ng from three DNA samples. As expected, the amount of PCR product
increased with the number of cycles. A full profile was generated at 26 cycles and
off-scale data were collected for several allele peaks at 30 cycles (Figure 17).

80

AmpFISTR® Identifiler® Plus User Guide



Developmental validation

Although none of the cycle numbers tested produced nonspecific peaks, 28 cycles

was found to give optimal peak heights with 1 ng of DNA input when the amplified
products were examined on Applied Biosystems® 3130x/ Genetic Analyzers.
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Figure 17 Representative AmpF(STR® Identifiler® Plus Kit profiles obtained from
amplification of 1.0 ng DNA template using 26, 27, 28, 29, and 30 cycles,
analyzed on the Applied Biosystems® 3130x/ Genetic Analyzer, Y-axis scale, (0 to
4,000 RFUs)

AmpFISTR® Identifiler® Plus User Guide

81



Chapter 5 Experiments and Results

Accuracy, precision, and reproducibility

SWGDAM
guideline 2.9

Accuracy

Size Difference (nt)

-0.25 -

-0.50 -

0.50 -

0.25 -

o
o
o

“The extent to which a given set of measurements of the same sample agree with
their mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000 and Wallin ef al., 2002). However,
accuracy and reproducibility of AmpF{STR Identifiler® Plus profiles have been
determined from various sample types. Figure 18 shows the size differences that are
typically observed between sample alleles and allelic ladder alleles on the Applied
Biosystems® 3130«¢ Genetic Analyzer with POP-4™ polymer. The x-axis in

Figure 18 represents the nominal nucleotide sizes for the AmpF(STR Identifiler®™
Plus Allelic Ladder. The dashed lines parallel to the x-axis represent the +0.25-nt
windows. The y-axis represents the deviation of each sample allele size from the
corresponding allelic ladder allele size. All sample alleles are within +£0.5 nt from a
corresponding allele in the allelic ladder.

©  CSFIPO
D251338
D3513568
& D5S818
+ D7saz20
o D8s1179
D138317
D165539
&  D18s51
©  D195433
a D218
©  FGA
THO1
o TPOX
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Allele Size (nt)

Figure 18 Size deviation of 200 samples analyzed on the Applied Biosystems®
3130x/ Genetic Analyzer. For each sample, 1.0 ng of DNA was amplified for
28 PCR cycles.
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Precision and Sizing precision allows for determining accurate and reliable genotypes. Sizing

size windows  precision was measured on the Applied Biosystems® 3130x/ Genetic Analyzer. The
recommended method for genotyping is to employ a +0.5-nt “window” around the
size obtained for each allele in the AmpF(STR Identifiler® Plus Allelic Ladder. A
+0.5-nt window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR Identifiler® Plus Allelic Ladder

or

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree
of precision in sizing an allele multiple times. Precision is measured by calculating
the standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument or in several lanes of one gel.

Table 4 on page 84 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF(STR® Identifiler® Plus Allelic Ladder on the
Applied Biosystems® 3130x/ Genetic Analyzer (36-cm capillary and POP-4™
polymer). The internal size standard that was used was GeneScan™ 500 LIZ® Size
Standard. The results were obtained within a set of injections on a single capillary
array.

Sample alleles may occasionally size outside of the +£0.5-nt window for a respective
allelic ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 18 on page 82 illustrates the tight clustering of allele sizes obtained
on the Applied Biosystems® 3130x/ Genetic Analyzer, where the standard deviation
in sizing is typically less than 0.15 nt. The instance of a sample allele sizing outside
the £0.5-nt window because of measurement error is relatively rare when the
standard deviation in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a £0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder. Repeat analysis,
when necessary, provides an added level of confidence to the final allele assignment.

GeneMapper® ID Software and GeneMapper® ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (off-ladder).

Maximum precision is obtained with a set of capillary injections on each of the
supported platforms however the determined allele sizes will vary between the
different platforms. Cross-platform sizing differences occur from a number of factors
including type and concentration of polymer, run temperature, and electrophoresis
conditions. Variations in sizing can also occur between runs on the same instrument
and between runs on different instruments of the same platform type because of these
factors.
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We strongly recommend that the allele sizes be compared to the sizes obtained for
known alleles in the AmpF(STR® Identifiler® Plus Allelic Ladder from the same run
and then be converted to genotypes (as described in “Before you start” on pages 46
and 60). See Table 4 for the results of five runs of the AmpF(STR® Identifiler® Plus
Allelic Ladder. For more information on precision and genotyping, see Lazaruk et
al., 1998 and Mansfield et al., 1998.

In Table 4, the mean sizes for all the alleles in each run (16 capillaries) were
calculated. The mean range shown in the table represents the lowest- and highest-
mean size values obtained across all five runs. Similarly, the standard deviation for
the allele sizing was calculated for all the alleles in each run. The standard deviation
range shown in Table 4 represents the lowest and highest standard deviation values
obtained across all five runs.

Table 4 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Identifiler® Plus Allelic Ladder

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation

Amelogenin

X 106.03-106.13 0.033-0.045
Y 111.69-111.8 0.03-0.042
CSF1PO

6 303.99-304.12 0.041-0.063
7 308.04-308.17 0.037-0.058
8 312.1-312.2 0.039-0.065
9 316.13-316.25 0.035-0.045
10 320.18-320.3 0.034-0.055
11 324.24-324.34 0.03-0.046

12 328.3-328.39 0.025-0.047
13 332.36-332.44 0.032-0.037
14 336.39-336.49 0.024-0.039
15 340.42-340.53 0.038-0.05

D13S317

8 216.36-216.48 0.031-0.064
9 220.34-220.48 0.035-0.051
10 224.32-224.45 0.034-0.059
11 228.31-228.45 0.031-0.065
12 282.42-32.55 0.031-0.063
13 236.3-236.43 0.038-0.066
14 240.24-240.37 0.043-0.058
15 244.23-244.37 0.037-0.066
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Table 4 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele

Mean

Standard Deviation

D16S539
5
8
9
10
11
12
13
14
15

D18S51

10
10.2
11
12
13
13.2
14
14.2
15
16
17
18
19
20
21
22
23
24
25
26
27

252.01-252.15
264-264.15
268-268.14
272-272.15
276.02-276.17
280.03-280.18
284.05-284.22
288.08-288.23
292.12-292.26

261.8-261.9
269.94-270.03
274.02-274.12
276.03-276.13
278.11-278.22
282.2-282.29
286.29-286.39
288.29-288.4
290.38-290.49
292.39-292.5
294.48-294.59
298.57-298.69
302.69-302.81
306.83-306.95
310.96-311.07
315.08-315.18
319.2-319.31
323.39-323.5
327.46-327.53
331.59-331.65
335.69-335.76
339.8-339.88
343.87-343.99

0.05-0.06
0.05-0.061
0.05-0.063
0.045-0.059
0.04-0.064
0.039-0.067
0.045-0.06
0.044-0.054
0.038-0.059

0.037-0.049
0.037-0.051
0.043-0.051
0.037-0.048
0.042-0.059
0.037-0.046
0.039-0.051
0.034-0.052
0.032-0.051
0.043-0.057
0.029-0.049
0.035-0.053
0.039-0.056
0.039-0.056
0.034-0.049
0.036-0.045
0.036-0.045
0.03-0.044
0.025-0.052
0.026-0.043
0.032-0.043
0.036-0.047
0.031-0.048
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Table 4 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
D19S433
9 101.25-101.34 0.022-0.034
10 105.16-105.25 0.028-0.037
11 109.09-109.17 0.021-0.033
12 113.04-113.12 0.024-0.036
12.2 115.06-115.13 0.027-0.035
13 117.02-117.09 0.026-0.036
13.2 119.03-119.1 0.027-0.038
14 121.02-121.07 0.025-0.038
14.2 123.05-123.1 0.028-0.037
15 125.03-125.09 0.03-0.041
15.2 127.08-127.13 0.027-0.04
16 129.08-129.13 0.031-0.039
16.2 131.13-131.19 0.023-0.042
17 133.16-133.21 0.034-0.046
17.2 135.23-135.28 0.034-0.041
D21S11
24 184.41-184.46 0.024-0.042
24.2 186.39-186.45 0.025-0.04
25 188.35-188.4 0.024-0.038
26 192.27-192.34 0.027-0.035
27 196.21-196.28 0.024-0.039
28 200.06-200.13 0.026-0.039
28.2 202.03-202.1 0.026-0.036
29 204.02-204.09 0.025-0.044
29.2 206.08-206.14 0.027-0.041
30 208.06-208.11 0.028-0.04
30.2 210.03-210.09 0.031-0.037
31 212.04-212.12 0.031-0.037
31.2 214.03-214.1 0.023-0.04
32 216.04-216.11 0.028-0.042
32.2 218.03-218.09 0.023-0.0351
33 220.05-220.1 0.031-0.043
33.2 221.98-222.05 0.033-0.038
34 224.12-224.18 0.024-0.033
34.2 226.03-226.09 0.029-0.041
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Table 4 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
35 228.1-228.17 0.03-0.048
35.2 230.03-230.09 0.03-0.037
36 232.02-232.09 0.03-0.047
37 236.08-236.17 0.026-0.041
38 240.04-240.1 0.033-0.045
D2S1338
15 306.27-306.39 0.033-0.058
16 310.35-310.47 0.031-0.055
17 314.39-314.53 0.029-0.042
18 318.45-318.58 0.029-0.046
19 322.52-322.63 0.025-0.046
20 326.58-326.67 0.029-0.039
21 330.66-330.74 0.034-0.045
22 334.71-334.8 0.031-0.043
23 338.74-338.85 0.026-0.045
24 342.75-342.89 0.026-0.05
25 346.78-346.92 0.026-0.051
26 350.77-350.89 0.028-0.049
27 354.69-354.81 0.026-0.045
28 358.87-359.01 0.028-0.045
D3S1358
12 111.12-111.22 0.024-0.047
13 115.23-115.32 0.03-0.046
14 119.2-119.31 0.03-0.044
15 123.14-123.22 0.031-0.045
16 127.32-127.41 0.032-0.042
17 131.54-131.62 0.027-0.039
18 135.64-135.71 0.021-0.042
19 139.72-139.81 0.024-0.045
D5S818
7 133.69-133.75 0.029-0.039
8 137.8-137.86 0.031-0.037
9 142.17-142.24 0.022-0.035
10 146.64-146.71 0.025-0.039
11 151.05-151.12 0.031-0.043
12 155.32-155.39 0.028-0.041
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Table 4 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
13 159.55-159.61 0.027-0.051
14 163.63-163.7 0.032-0.038
15 167.68-167.74 0.026-0.051
16 171.7-171.76 0.035-0.04

D7S820
6 255.08-255.19 0.029-0.058
7 259.13-259.22 0.04-0.056
8 263.16-263.25 0.037-0.053
9 267.19-267.29 0.046-0.053
10 271.25-271.34 0.039-0.051
11 275.28-275.4 0.037-0.06
12 279.34-279.45 0.034-0.05
13 283.38-283.49 0.039-0.049
14 287.44-287.54 0.039-0.051
15 291.51-291.62 0.043-0.052

D8S1179
8 122.49-122.61 0.03-0.044
9 126.56-126.68 0.037-0.045
10 130.66-130.76 0.026-0.044
11 134.8-134.89 0.031-0.041
12 138.98-139.09 0.019-0.043
13 143.58-143.68 0.028-0.042
14 148.03-148.14 0.03-0.046
15 152.43-152.54 0.025-0.043
16 156.73-156.83 0.026-0.039
17 160.93-161.04 0.031-0.042
18 165.03-165.12 0.024-0.046
19 169.1-169.2 0.035-0.044

FGA
17 214.11-214.23 0.041-0.05
18 218.14-218.26 0.043-0.052
19 222.17-222.3 0.039-0.054
20 226.21-226.35 0.044-0.057
21 230.26-230.38 0.045-0.055
22 234.29-234.42 0.05-0.058
23 238.33-238.47 0.038-0.057°
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Table 4 Precision results of five runs (16 capillaries/run) of the

AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
24 242.37-242.52 0.044-0.067
25 246.42-246.57 0.044-0.056
26 250.48-250.62 0.038-0.069

26.2 252.49-252.64 0.046-0.066
27 254.5-254.65 0.047-0.057
28 258.55-258.71 0.045-0.064
29 262.63-262.78 0.049-0.062
30 266.72-266.88 0.052-0.069

30.2 268.53-268.7 0.049-0.065

31.2 272.62-272.78 0.036-0.062

32.2 276.71-276.86 0.05-0.068

33.2 280.77-280.94 0.043-0.069

42.2 317.89-318.06 0.045-0.062

43.2 322.01-322.16 0.038-0.055

44.2 326.14-326.27 0.034-0.05

45.2 330.28-330.39 0.039-0.048

46.2 334.28-334.4 0.044-0.05

47.2 338.37-338.49 0.039-0.055

48.2 342.51-342.66 0.034-0.055

50.2 350.59-350.76 0.041-0.061

51.2 354.54-354.7 0.039-0.063

THO1
4 162.72-162.77 0.025-0.04
5 166.78-166.84 0.027-0.035
6 170.82-170.87 0.03-0.046
7 174.83-174.9 0.029-0.045
8 178.84-178.9 0.02-0.046
9 182.82-182.89 0.027-0.034
9.3 185.84-185.9 0.022-0.042
10 186.77-186.83 0.026-0.036
11 190.71-190.77 0.027-0.034
12 201.48-201.55 0.026-0.037
TPOX
6 221.82-221.91 0.029-0.05
225.8-225.88 0.029-0.053
8 229.79-229.86 0.034-0.048
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Table 4 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Identifiler® Plus Allelic Ladder (continued)

Applied Biosystems® 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
9 233.77-233.86 0.039-0.048
10 237.76-237.83 0.025-0.053
11 241.75-241.83 0.028-0.04
12 245.78-245.85 0.04-0.049
13 249.76-249.85 0.036-0.048

VWA

11 154.07-154.14 0.028-0.042
12 158.26-158.34 0.028-0.04
13 162.42-162.49 0.031-0.043
14 166.66-166.73 0.031-0.05
15 170.59-170.66 0.029-0.044
16 174.62-174.68 0.03-0.04

17 178.61-178.67 0.028-0.051
18 182.54-182.61 0.021-0.037
19 186.5-186.56 0.024-0.043
20 190.43-190.49 0.028-0.04
21 194.29-194.36 0.024-0.044
22 198.17-198.24 0.023-0.036
23 202.01-202.09 0.028-0.041
24 206.36-206.42 0.034-0.041

Extra peaks in the electropherogram

Causes of extra
peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete

3" A nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples
(see DAB Standard 8.1.2.2).

Stutter products

A stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major
STR product (Butler, 2005 and Mulero et al., 2006). Sequence analysis of stutter
products at tetranucleotide STR loci has revealed that the stutter product is missing a
single tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).
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The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for samples (n = 500) amplified using the
28-cycle-protocol (DNA input ~1ng) at the loci used in the Identifiler® Plus Kit. All
data were generated on the Applied Biosystems® 3130x] Genetic Analyzer.

Some conclusions from these measurements and observations are:

+ For each AmpF(STR® Identifiler® Plus Kit locus, the percent stutter generally
increases with allele length, as shown in Figure 19 to Figure 22 on pages 92
through 94.

* Smaller alleles display a lower level of stutter relative to the longer alleles
within each locus.

* Each allele within a locus displays a percent stutter that is consistent with other
alleles in the locus.

» The stutter value for each locus shown in Table 5 on page 94 was determined
by taking the mean plus three times the standard deviation. These values are the
stutter filter percentages in the Identifiler® Plus stutter file; they will be used
during the filtering step in the GeneMapper® ID Software v3.2.1 or
GeneMapper® ID-X Software v1.0.1, v1.1, or v1.1.1. Peaks in the stutter
position that are above the stutter filter percentage will not be filtered. Peaks in
the stutter position that have not been filtered and remain labeled can be further
evaluated. For evaluation of mixed samples, see Figure 30 on page 108.

» The percent stutter cannot be accurately measured for allele peaks that are
off-scale and may appear unusually high relative to the main peak.
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Percent Stutter
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Percent Stutter
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Figure 22 Stutter percentages for the D5S818 and FGA loci

Table 5 Marker-specific stutter filter percentages for AmpF(STR®

Identifiler® Plus PCR Ampilification Kit loci#

Locus % Stutter
CSF1PO 9.2041
D13S317 9.9348
D16S539 10.3945
D18S51 13.6799
D195433 11.2096
D21S11 10.6714
D251338 12.4409
D3S1358 12.2719
D5S818 10.0599
D7S820 9.6926
D8S1179 10.3155

FGA 13.028

THO1 4.0813
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Extra peaks in the electropherogram

Table 5 Marker-specific stutter filter percentages for AmpF(STR®
Identifiler® Plus PCR Amplification Kit loci* (continued)

Locus % Stutter
TPOX 6.3832
vWA 12.446

1 These percentages are used as stutter filters in used in GeneMapper ID v3.2.1
Identifiler_Plus_Panels_v1 and GeneMapper® ID-X software v1.0.1, v1.1, or v1.1.1
Identifiler_Plus_Panels_v1x.

Addition of 3" A nucleotide

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominately adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988 and Magnuson et al., 1996). This nontemplate addition results in a PCR
product that is one nucleotide longer than the actual target sequence. The PCR
product with the extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the
3" end of the PCR product. The Identifiler® Plus Kit includes two main design
features that promote maximum +A addition:

* The primer sequences have been optimized to encourage +A addition.

» The final extension step is 60 °C for 10 min.
This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. STR systems (where each allele is

represented by two peaks that are one nucleotide apart) that have not been optimized
for +A addition may have “split peaks.”
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Artifacts
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Figure 23 Omitting the final extension step results in split peaks due to
incomplete A nucleotide addition. Data are from an ABI PRisM® 310 Genetic
Analyzer using another AmpF{STR kit.

Lack of complete +A nucleotide addition may be observed in AmpF(STR®
Identifiler® Plus PCR Amplification Kit results when the amount of input DNA is
greater than the recommended protocols, because more time is needed for the
enzyme to add the +A nucleotide to all molecules as more PCR product is generated.
Amplification of too much input DNA may also result in off-scale data.

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent
occurrences that are not observed consistently in a system (for example, spikes and
baseline noise). Reproducible artifacts have not been seen in data produced, with
either 28 or 29 cycles of amplification, on the genetic analyzers used during
developmental validation of the Identifiler® Plus Kit.

However, you should consider possible noise and artifacts when interpreting data
from the AmpF(STR® Identifiler® Plus PCR Amplification Kit on the Applied
Biosystems® 3130/3130x/, ABI PRISM® 3100/3100-Avant, and ABI PRiSM® 310
Genetic Analyzers.
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Characterization of loci

Characterization of loci

SWGDAM
guideline 2.1

Nature of the
polymorphisms

Inheritance

“The basic characteristics of a genetic marker must be determined and documented.”
(SWGDAM, July 2003)

This section describes basic characteristics of the 15 loci and the sex-determining
marker, Amelogenin, which are amplified with the AmpF(STR® Identifiler® Plus
Kit. These loci have been extensively characterized by other laboratories.

The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1
of the X homologue. Amplification results in 107-nt and 113-nt products from the X
and Y chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3" A nucleotide addition.) The remaining AmpF{STR®
Identifiler® Plus Kit loci are all tetranucleotide short tandem repeat (STR) loci. The
length differences among alleles of a particular locus result from differences in the
number of 4-nt repeat units.

All the alleles in the AmpF(STR® Identifiler® Plus Allelic Ladder, including
microvariants, have been subjected to sequencing. In addition, other groups in the
scientific community have sequenced alleles at some of these loci (Nakahori ef al.,
1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Brinkmann and
Moller, 1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998;
Mombhinweg et al., 1998; Watson et al., 1998). Among the various sources of
sequence data on the AmpF¢STR®™ Identifiler® Plus Kit loci, there is consensus on
the repeat patterns and structure of the STRs.

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying
inheritance patterns (Begovich ef al., 1992).

Three CEPH family DNA sets were examined. One nanogram of DNA from each
sample was amplified using the Identifiler® Plus Kit, followed by analysis using an
Applied Biosystems® 3130x/ Genetic Analyzer. The families examined included
#1333 (9 offspring), #1340 (7 offspring), and #1345 (7 offspring), representing

23 meiotic divisions.

In family #1340, we observed two parent/offspring pairs with mutations at locus
D8S1179. The genotypes differed by one repeat unit between the two generations.
Calculation of a mutation rate based on these data would be inaccurate due to the
small sample size. The other parent-offspring allele transfers were in accordance
with Mendelian rules.
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Mapping

The Identifiler® Plus Kit loci Amelogenin, CSF1PO, D2S1338, D3S1358, D5S818,
D7S1179, D13S317, D16S539, D18S51, D19S433, D21S11, FGA, THO1, TPOX,
and vWA have been mapped, and the chromosomal locations have been published
(Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Kong et al., 2004;
Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber
and Parkin, 1996).

Species specificity

SWGDAM
Guideline 2.2

“For techniques designed to type human DNA, the potential to detect DNA from
forensically relevant nonhuman species should be evaluated.” (SWGDAM, July
2003)

The AmpF(STR® Identifiler® Plus PCR Amplification Kit provides the required
specificity for detecting human alleles.

Nonhuman studies

Nonhuman DNA may be present in forensic casework samples. The data from
AmpF(STR® Identifiler® Plus PCR Amplification Kit experiments on nonhuman
DNA sources are shown in Figure 24 on page 99.

Figure 24 shows amplification for: Control DNA 9947A (1.0 ng, panel 1),
chimpanzee (1.0 ng, panel 2), dog (10 ng. panel 3), cat (10 ng, panel 4), horse (10 ng,
panel 5), microbial DNA pool (equivalent to 105 copies of Candida albicans,
Staphylococcus aureus, Neisseria gonorrhoeae, E. coli 0157:H7, Bacillus subtilis,
and Lactobacillus rhamnosus, panel 6), and the negative control (panel 7). The
extracted DNA samples were amplified with the AmpF(STR® Identifiler® Plus PCR
Amplification Kit and analyzed using the Applied Biosystems® 3130x/ Genetic
Analyzer.

» Primates: gorilla, chimpanzee, orangutan, and macaque (1.0 ng each)

* Non-primates: mouse, dog, sheep, rabbit, cat, horse, hamster, rat, chicken, and
cow (10 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus, Escherichia coli,
Neisseria gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus
(equivalent to 10° copies)

The chimpanzee and gorilla DNA samples produced partial profiles within the 70 to
350 nucleotide region.

The microorganisms, chicken, hamster, mouse, rabbit, and rat did not yield
detectable products. Dog, horse, sheep, and cow produced a 98-bp fragment near the
amelogenin locus in the PET® dye.
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Figure 24 Representative electropherograms from a species specificity study
including positive and non-template controls (NTC) run for 28 PCR cycles
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Sensitivity

SWGDAM
guideline 2.3

Importance of
quantitation

Effect of DNA
quantity on
results

“When appropriate, the range of DNA quantities able to produce reliable typing
results should be determined.” (SWGDAM, July 2003)

The optimal amount of input DNA added to the AmpF(STR® Identifiler® Plus PCR
Amplification Kit should be between 0.75 and 1.0 ng for 28-cycle amplification. The
DNA sample should be quantitated before amplification using a system such as the
Quantifiler® Human DNA Quantification Kit (PN 4343895) or the Quantifiler® HP
(Human Plus) DNA Quantification Kit (PN 4482911). The final DNA concentration
should be 0.075 to 0.1 ng/uL so that 0.75 to 1.0 ng of DNA is added to the PCR
reaction in a volume of 10 uL. If the sample contains degraded or inhibited DNA,
amplification of additional DNA may be beneficial. In Figures 25 and 26, the control
DNA 9947A was serially diluted from 1 ng to 0.031 ng. With the 28-PCR-cycle
protocol, full profiles (26 alleles) were consistently obtained at 0.125 ng, but
occasional partial profiles that are missing anywhere from 1 to 3 alleles were
observed at 0.062 ng. With the 29-PCR-cycle protocol, full profiles (26 alleles) were
consistently obtained at 0.062 ng, but occasional partial profiles that are missing
anywhere from 1 to 5 alleles were observed at 0.031 ng.

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the instrument (“off-scale” data)

Off-scale data is a problem because:
— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter

peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).
* Incomplete +A nucleotide addition

The sample can be reamplified using less DNA.

When the total number of allele copies added to the PCR is extremely low,
unbalanced amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA. For information on selecting the appropriate cycle number for your DNA
input amount, see “Select the appropriate PCR cycle number” on page 29.
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Figure 25 Effect of amplifying 1 ng, 0.50 ng, 0.25 ng, 0.125 ng, and 0.062 ng of
Control DNA 9947A using the 28-PCR-cycle protocol
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Figure 26 Effect of amplifying 0.5 ng, 0.25 ng, 0.125 ng, 0.062 ng, and 0.031 ng
of Control DNA 9947A using the 29-PCR-cycle protocol

Note that the y-axis scale is magnified for the lower amounts of DNA, analyzed
using the Applied Biosystems® 3130x/ Genetic Analyzer.
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Stability

Degraded DNA

SWGDAM
guideline 2.4

130

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults
has been extensively documented. In most instances, assessment of the effects of
these factors on new forensic DNA procedures is not required. However, if substrates
and/or environmental and/or chemical insults could potentially affect the analytical
process, then the process should be evaluated using known samples to determine the
effects of such factors.” (SWGDAM, July 2003)

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This reduction is due to the reduced
number of intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for differential amplification
of loci. High-molecular-weight Raji DNA was sonicated and incubated with
increasing doses of DNase I (0 to 6 Units) for 20 minutes (Bender et al., 2004). The
DNA was examined by agarose gel analysis to determine the average size of the
DNA fragments at each time point.

One nanogram of degraded DNA was amplified using the AmpF(STR® Identifiler®
Plus Kit. As the DNA became increasingly degraded, the loci became undetectable
according to size. Preferential amplification was not observed. The loci failed to
robustly amplify in the order of decreasing size as the extent of degradation
progressed.
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Figure 27 28-PCR-cycle amplification of Raji DNA samples sonicated and
incubated with increasing doses of DNase I. Panels 1, 2, 3, 4, and 5 correspond
to 0, 3, 4, 5, and 6 units of DNase I.
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Effect of
inhibitors —
hematin

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al., 1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA, and that it subsequently
interferes with PCR by inhibiting polymerase activity.

To examine the effects of hematin on the amplification results obtained by the
Identifiler® Plus Kit, Control DNA 9947A (1 ng input DNA) was amplified with
increasing concentrations of hematin for 28 cycles of amplification (Figure 28 on
page 103). The concentrations of hematin used were 0 uM, 100 uM, 200 uM, and
300 uM (see Table 6).
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Figure 28 Amplification with the AmpF(STR® Identifiler® Plus Kit in the presence
and absence of hematin. Panel 1 corresponds to control samples; panels 2-4
correspond to samples amplified in the presence of 100, 200, and 300 uM of
hematin.

Table 6 Performance in simulated model of hematin inhibition
(n=3)%

Identifiler® Plus Kit

Hematin (uM) Alleles detected/Total alleles

0 26/26, 26/26, 26/26

100 26/26, 26/26, 26/26
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Table 6 Performance in simulated model of hematin inhibition
(n = 3) (continued)*

Identifiler® Plus Kit

Hematin (uM) Alleles detected/Total alleles

200 26/26, 26/26, 26/26

300 26/26, 26/26, 26/26

I Only those peaks >50 RFUs were counted. A complete profile with Control 9947A DNA
yields 26 peaks using the AmpF{STR® Identifiler® Plus Kit

Effect of Traces of humic acid may inhibit the PCR amplification of DNA evidence collected
inhibitors —  from soil. In this study, We tested increasing amounts of humic acid in the PCR
humic acid amplification of 1 ng of Control DNA 9947A with the Identifiler® Plus Kit for 28
cycles of amplification (see Figure 29). The concentrations of humic acid tested were
0, 50, 100, and 150 ng/uL (see Table 7).
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Figure 29 Amplification with the AmpF(STR® Identifiler® Plus PCR Amplification
Kit in the presence and absence of humic acid. Panel 1 corresponds to control
samples; panels 2-4 correspond to samples amplified in the presence of 50, 100,
and 150 ng/pL humic acid.
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Table 7 Performance in simulated model of humic acid inhibition

(n=3)*
Humic Acid (ng/uL) Identifiler® Plus Kit
0 26/26, 26/26, 26/26
50 26/26, 26/26, 26/26
100 26/26, 26/26, 26/26
150 26/26, 26/26, 26/26

T Only those peaks >50 RFUs were counted. A complete profile with Control 9947A DNA
yields 26 peaks using the AmpF{STR® Identifiler® Plus Kit.

Mixture studies

SWGDAM  “The ability to obtain reliable results from mixed source samples should be
guideline 2.8  determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual. The possibility
of multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories assign a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Mixture Studies Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore, it is
essential to ensure that the DNA typing system is able to detect DNA mixtures.
Mixed samples can be distinguished from single-source samples by:

» The presence of more than two alleles at a locus
» The presence of a peak at a stutter position that is significantly greater in
percentage than what is typically observed in a single-source sample

+ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by
the height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the AmpF(STR®
Identifiler® Plus PCR Amplification Kit loci in unmixed population database
samples are shown in Table 8.
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Table 8 Peak height ratios for ~1.0 ng* of input DNA amplified for 28 PCR

cycles
Number of
Locus Obsel(';;:\tions Mean Median Minimum | Maximum
Amel 320 90.23 91.29 46.21 99.89
CSF1PO 378 90.37 91.56 67.19 99.96
D13S317 375 90.61 92.09 68.28 99.94
D16S539 389 90.03 91.15 68.11 99.87
D18S51 432 90.06 91.24 62.26 99.94
D19S433 399 90.2 91.2 57.29 99.96
D21S11 428 90.3 91.12 69.05 100
D2S1388 436 90.36 91.56 63.86 100
D3S1358 356 91.39 92.66 62.82 99.94
D5S818 357 91.15 92.21 66.07 100
D7S820 395 90.49 92.07 46.61 99.94
D8S1179 396 91.22 92.7 67.42 100
FGA 429 89.83 91.07 60.38 99.87
THO1 362 91.62 93.04 70.09 100
TPOX 333 91.17 92.18 70.65 100
VWA 414 91.16 92.33 65.22 100

I Actual DNA input amounts: 0.7 ng to 1.3 ng

If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of
imbalance at a locus are:

Degraded DNA

Presence of inhibitors

Extremely low amounts of input DNA

A mutation in one of the primer binding sites

Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

Resolution of genotypes in mixed samples

A sample containing DNA from two sources can comprise (at a single locus) any of

the seven genotype combinations (see below).
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* Heterozygote + heterozygote, no overlapping alleles
(four peaks)

* Heterozygote + heterozygote, one overlapping allele
(three peaks)

* Heterozygote + heterozygote, two overlapping alleles
(two peaks)

* Heterozygote + homozygote, no overlapping alleles
(three peaks)

» Heterozygote + homozygote, overlapping allele
(two peaks)

* Homozygote + homozygote, no overlapping alleles
(two peaks)

* Homozygote + homozygote, overlapping allele
(one peak)

Specific genotype combinations and input DNA ratios of the samples contained in a
mixture determine whether or not it is possible to resolve the genotypes of the major
and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems® instruments provides additional valuable data to aid
in resolving mixed genotypes. This quantitative value is much less subjective than
comparing relative intensities of bands on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case.

Limit of detection of the minor component

Mixtures of two genomic DNA samples were examined at various ratios (0:1, 1:1,
3:1,7:1, 10:1, 15:1, 1:0). The total amount of genomic input DNA mixed at each
ratio was 1 ng. The samples were amplified in a GeneAmp® PCR System 9700, then
electrophoresed and detected using an Applied Biosystems® 3130x/ Genetic
Analyzer.

The results of the mixed DNA samples are shown in Figures 30 (28 PCR cycles) and
31 (29 PCR cycles) on page 108 where samples A and B were mixed according to the
ratios provided. Using either the 28- or 29-PCR-cycle protocol, the minor component
allele calls at non-overlapping loci are highlighted. The amplification of the minor
contributor at 3:1, 7:1 (0.875:0.125 ng), and 10:1 (0.9:0.09 ng) mixture ratios was
readily typeable. 15:1 (0.9375:0.0625 ng) mixture ratios resulted in full or partial
profiles for the minor component. The profiles of these samples are described in
Table 9.
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Figure 30 Ampilification of DNA mixtures at various ratios using the 28-PCR-
cycle protocol. Minor allele peaks that do not overlap with the major contributor

peaks are highlighted.
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Amplification of DNA mixtures at various ratios using the 29-PCR-

cycle protocol. Minor allele peaks that do not overlap with the major contributor

peaks are highlighted.

Table 9 Genotypes of mixed DNA samples

Locus Profile Sample A Profile Sample B
D8S1179 11,14 10, 11
D21S11 29, 35 31.2,32.2
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Table 9 Genotypes of mixed DNA samples (continued)

Locus Profile Sample A Profile Sample B
D7S820 8,10 11
CSF1PO 8,10 12
D3S1358 14,17 15,16

THO1 7,8 6,9.3
D13S317 12,13 9, 11
D16S539 10, 11 9,12
D2S1338 17,23 17,20
D19S433 11,17.2 13

VWA 14,17 17,19

TPOX 9,10 8, 11
D18S51 15,16 13, 14

AMEL X, Y X
D5S818 11,13 8,10

FGA 19, 25 22,23
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Population Data

SWGDAM  “The distribution of genetic markers in populations should be determined in relevant
guideline 2.7  population groups.” (SWGDAM, July 2003)

Overview To interpret the significance of a match between genetically typed samples, you must
know the population distribution of alleles at each locus in question. If the genotype
of the relevant evidence sample is different from the genotype of a suspects reference
sample, then the suspect is excluded as the donor of the biological evidence that was
tested. An exclusion is independent of the frequency of the two genotypes in the
population.

If the suspect and evidence samples have the same genotype, then the suspect is
included as a possible source of the evidence sample. The probability that another,
unrelated individual would also match the evidence sample is estimated by the
frequency of that genotype in the relevant population(s).

Population The AmpF(STR® Identifiler® PCR Amplification Kit, prior to the addition of the
samples used in  D8S1179 degenerate primer, was used to generate the population data provided in
these studies this section. Samples were collected from individuals throughout the United States
with no geographical preference.

African-American

357 samples were provided by the Kentucky State Police and the Federal Bureau of
Investigation.

U.S. Caucasian

349 samples were provided by the Kentucky State Police and the Federal Bureau of
Investigation.

U.S. Hispanic

290 samples were provided by the Minnesota Bureau of Criminal
Apprehension/Memorial Blood Center of Minneapolis and the Federal Bureau of
Investigation.

Native American

191 samples were provided by the Minnesota Bureau of Criminal
Apprehension/Memorial Blood Center of Minneapolis.

In addition to the alleles that were observed and recorded in our databases, other
alleles have been published or reported by other laboratories (see the STRBase at
www.cstl.nist.gov/div831/strbase).
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AmpF(STR®  Table 10 shows the AmpF(STR® Identifiler® Plus Kit allele frequencies in four
Identifiler® Plus  populations, listed as percentages.
Kit allele

. Table 10 AmpF/{STR Identifiler Plus Kit allele frequencies
frequencies

Afric_an- U.S.. U.S. Hispanic Nati_ve
Allele American Caucasian (n = 290) American
(n = 357) (n = 349) (n=191)
CSF1PO
6 + + + ¥
7 4.62 0.14% 0.34% I
8 7.56 0.29% 0.17% 0.52%
9 3.78 1.72 0.86% 8.38
10 27.87 24.21 23.10 30.89
11 20.59 31.91 28.28 21.99
11.3 0.14% * * *
12 29.13 32.81 39.66 32.72
13 5.32 7.31 6.38 4.71
14 0.98 1.43 0.86% 0.79%
15 * 0.29% ¥ ¥
D2S1338
15 0.14% * * *
16 5.32 4.73 2.41 2.62
17 10.78 17.34 21.21 9.95
18 5.60 6.30 4.14 7.07
19 14.15 13.75 22.76 29.58
20 6.02 14.61 13.79 9.69
21 14.01 2.58 2.59 2.38
22 13.17 4.01 7.41 15.18
23 10.78 11.46 11.36 11.78
24 9.80 11.75 8.45 7.85
25 8.12 10.60 5.17 3.14
26 1.96 2.72 0.69% 0.79%
27 0.14% 0.14% * *
28 ¥ ¥ ¥ ¥
D3S1358
<11 0.42% 0.14% * *
11 * * ¥ 0.26%
12 0.56+ * 0.17% *
13 0.70% 0.29% 0.17% *
14 12.04 15.76 7.41 6.81
15 30.53 25.36 39.14 40.84
15.2 0.14% * * *
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Ameriemn Gancenian U'?r'l ';“zgg)"ic Amerioan
(n = 357) (n = 349) (n=191)
16 28.57 22.78 26.72 32.98
17 19.47 18.19 16.03 9.95
18 6.72 16.48 8.97 8.38
19 0.84 1.00 1.03 0.79%
20 * * 0.34% *
D5S818
7 0.14% * 6.72 15.71
8 5.46 * 0.69* ¥
9 1.68 4.15 5.17 6.02
10 6.72 5.44 5.17 4.19
11 25.49 39.26 39.14 41.10
12 36.41 35.24 29.31 23.30
13 21.57 15.47 12.59 9.42
14 2.38 0.14% 0.69% 0.26%
15 * 0.29% 0.18t ¥
16 * * 0.17% ¥
17 0.14% * 0.17¢ t
D75820
6 * 0.14% 0.17% ¥
7 0.42% 1.29 1.72 0.52%
8 18.77 16.48 11.72 13.09
9 13.73 17.62 6.21 8.12
10 34.45 27.22 27.41 21.99
11 19.89 18.05 28.79 28.80
12 10.78 14.76 20.17 24.08
13 1.54 3.72 3.45 3.40
14 0.42% 0.72 0.34% ¥
15 ¥ ¥ ¥ ¥
D8S1179
8 0.42% 2.29 0.34% 0.52%
9 0.42% 1.15 0.34% 0.26%
10 2.38 9.74 8.45 4.71
11 3.92 6.02 5.86 3.40
12 13.31 14.04 12.07 11.52
13 23.25 32.52 32.93 37.43
14 30.11 21.35 26.21 30.63
15 20.17 9.89 10.86 9.42
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Ameriemn Gancenian U'?r'l ';“zgg)"ic Amerioan
(n = 357) (n = 349) (n=191)
16 4.62 2.72 2.41 1.57
17 1.12% 0.29% 0.52% 0.52%
18 0.28t * ¥ ¥
19 ¥ ¥ ¥ ¥
D13S317
8 3.08 12.18 9.66 4.97
9 2.52 7.74 21.72 17.80
10 3.78 4.44 9.14 13.61
11 24.51 29.80 23.10 24.35
12 46.22 30.80 20.86 23.04
13 15.41 11.17 10.17 7.85
14 4.34 3.72 5.34 8.12
15 0.14% 0.14% ¥ 0.26%
D16S539
5 ¥ ¥ ¥ ¥
8 3.22 1.72 1.72 0.79%
9 19.05 10.46 9.31 12.30
10 10.92 5.59 15.69 15.45
11 31.51 31.95 30.17 30.89
12 18.77 30.23 29.48 27.75
13 14.85 16.76 11.55 10.73
14 1.54 3.01 2.07 2.09
15 0.14% 0.29% t t
D18S51
7 ¥ ¥ ¥ ¥
9 0.14% * t t
10 0.28t 0.86 0.52% 0.79%
10.2 0.14% * ¥ ¥
11 0.28t 1.15 1.21% t
12 7.00 13.90 10.34 14.92
13 4.34 12.18 14.48 9.16
13.2 0.42% * t t
14 6.86 16.76 15.52 26.96
14.2 0.28% * ¥ ¥
15 19.47 13.61 16.55 12.04
16 16.53 13.61 11.72 10.73
17 18.21 12.32 14.14 14.66
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Ameriemn Gancenian U'?r'l ';“zgg)"ic Amerioan
(n = 357) (n = 349) (n=191)
18 11.90 7.74 6.72 2.62
19 6.02 4.44 4.14 3.93
20 4.90 1.72 2.24 1.83
21 2.10 1.00 1.03 1.31
22 0.70% 0.43% 0.52% 0.79%
23 0.42% 0.14% 0.52% 0.26%
24 * 0.14% 0.17% ¥
25 * ¥ 0.17% ¥
26 ¥ ¥ s ¥
27 ¥ ¥ ¥ ¥
D19S433
9 * 0.14% 0.17% ¥
10 1.54 * * ¥
11 7.14 0.72 0.52% 0.52%
11.2 0.14% * 0.17% ¥
12 10.78 7.74 6.21 3.14
12.2 6.30 0.57% 1.90 ¥
13 29.83 28.94 16.03 17.80
14 21.01 34.10 31.72 24.87
14.2 4.20 0.86 5.00 3.66
15 4.76 15.76 13.45 13.35
15.2 3.36 2.72 8.79 10.73
16 2.38 415 4.31 3.93
16.2 2.38 1.72 2.93 1.83
17 * 0.29% 0.17% 0.79%
17.2 0.28% 0.29% + 2.88
18.2 0.14% 0.29% * 1.05%
D21S11
24 ¥ ks ks s
24.2 0.14% 0.43% 0.17% ¥
24.3 * * * ¥
25 ¥ ks ks s
25.2 * 0.14* 0.17% ¥
26 0.14% 0.14% 0.17% ¥
27 5.04 4.58 1.21 0.52%
28 22.97 16.76 9.14 6.28
28.2 ¥ ¥ ¥ ¥
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Ameriemn Gancenian U'?r'l ';“zgg)"ic Amerioan
(n = 357) (n = 349) (n=191)
29 19.33 20.49 21.21 16.75
29.2 0.14% * 0.52% 0.26%
29.3 0.14% * * ¥
30 17.23 25.21 29.31 34.29
30.2 1.40 3.30 2.93 1.83
31 7.98 7.16 6.72 5.76
31.2 7.98 9.46 8.62 18.85
32 1.12 1.43 1.55 0.79%
32.2 5.88 7.16 12.93 9.69
33 0.56% * * 0.52%
33.2 3.78 3.30 4.14 3.66
34 1.26 * * ¥
34.1 0.14% * * ¥
34.2 0.14% 0.29% 0.86% 0.79%
35 2.94 * 0.34% ¥
35.1 0.14% * * ¥
35.2 * 0.14% 1 t
36 0.84 * * ¥
37 0.28% * * ¥
38 0.14% * 1 t
FGA
16 * 0.14% * ¥
16.1 0.14% * 1 t
17 * 0.29% 0.17% ¥
17.2 0.14% * * ¥
18 0.70% 2.72 0.52% 1.31
18.2 1.40 * * ¥
19 6.72 6.16 7.07 10.21
19.2 0.28% * * *
20 7.00 13.90 7.41 12.30
20.2 * 0.14% * ¥
21 12.89 16.91 14.66 12.83
22 21.57 16.91 17.24 10.47
222 0.28% 1.29 0.34% 0.26%
22.3 0.14% 0.14% 1 ¥
23 14.99 15.19 11.90 15.97
23.2 0.14% 0.14% 0.86% 0.26%
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Amerisan Caucasian S eae Amorican
(n = 357) (n = 349) (n=191)
24 17.51 13.75 15.34 15.71
242 * 0.14% 0.17% *

25 7.98 8.60 14.14 14.14

26 3.50 2.72 6.90 4.45
26.2 * * * 0.52

29 0.56% * + *

30 ¥ ¥ ¥ t
30.2 0.14% * * *
31.2 ¥ ¥ ¥ t
322 ¥ ¥ ¥ t
31.2 ¥ ¥ ¥ t
33.2 ¥ ¥ ¥ t
34.2 0.14% ¥ I 1
4292 ¥ ¥ ¥ t
43.2 ¥ ¥ ¥ t
44.2 0.28% I I
45.2 ¥ t t 0.26*
46.2 0.14% I I I
472 ¥ ¥ ¥ t
48.2 0.14% ¥ ¥ I
50.2 ¥ ¥ ¥ t
51.2 ¥ ¥ ¥ t

THO1

4 ¥ ¥ ¥ t

5 0.28% 0.43% 0.17% *

6 11.06 20.49 22.76 20.68

7 42.86 21.78 33.62 43.98

8 20.73 11.46 8.45 5.24
8.3 * 0.14% + *

9 12.32 16.19 14.14 6.28
9.3 11.62 29.08 20.34 23.56
10 0.98 0.43% 0.52% 0.26%
11 ¥ ¥ b ¥

13.3 0.14% * + *
TPOX
6 6.72 0.14% 0.34% ¥
2.24 * 0.34% 0.26%
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Table 10 AmpF(STR Identifiler Plus Kit allele frequencies (continued)

Allele Ameriemn Gancenian U'?r'l ';“zgg)"ic Amerioan
(n = 357) (n = 349) (n = 191)
8 36.13 53.30 49.66 37.96
9 21.15 11.60 7.24 4.19
10 9.24 4.30 4.66 3.40
11 21.43 25.93 27.24 39.27
12 3.08 4.73 10.52 14.92
13 ¥ ¥ ¥ ¥
VWA

11 0.28* t 0.17% :
12 t t : 0.26+
13 1.26 0.43 t 0.26*
14 7.14 8.31 6.90 4.45
15 20.03 11.32 10.00 7.07
16 26.75 23.35 34.31 32.98
17 20.59 24.50 21.55 33.51
18 14.71 22.49 18.45 15.45
19 6.72 8.31 7.07 4.71
20 1.96 115 1.38 1.05¢
21 0.28* t 017 0.26+
22 0.28* t £ :
23 ¥ ¥ ¥ ¥
24 t 0.14 : :

T A minimum allele frequency (0.7% for the African-American database, 0.7% for the U.S. Caucasian
database, 0.9% for the U.S. Hispanic database, and 1.3% for the Native American database) is
suggested by the National Research Council in forensic calculations.

Low-frequency alleles

Some alleles of the AmpF£STR® Identifiler® Plus Kit loci occur at a low frequency.
For these alleles, a minimum frequency (5 divided by 2n, where n equals the number
of individuals in the database) was assigned for the AmpF{STR Identifiler Plus Kit
African-American, Native-American, U.S. Caucasian, and U.S. Hispanic databases,
as suggested in the 1996 report of the Committee on DNA Forensic Science
(National Research Council, 1996). These databases are summarized in Table 10 on
page 112. The minimum reportable genotype frequency at each locus is: 1.19 X 10~
for the African-American database; 1.19 X 10~ for the U.S. Caucasian database;
1.70 X 107 for the U.S. Hispanic database; and 2.97 X 10~* for the Native American
database [p2 + p(1-p) 6, where 6 = 0.01].
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Evaluation of Estimates of expected heterozygosity (HExp) were computed as described by Nei,
Hardy-Weinberg M. (1973) using the program PopGene 1.32. Possible divergence from
equilibrium  Hardy-Weinberg expectations (HWE) was tested using various methods:

* By calculating the unbiased estimate of the expected homozygote/heterozygote
frequencies (Nei, M., 1978).

+ Using chi-square (HW X?p) and likelihood ratio (HW G?p) tests (as
implemented in the program PopGene 1.32).

* With an exact test (HW Exact p), which is a Markov chain method, based on
1000 shuffling experiments, to estimate without bias the exact P-value of the
Hardy-Weinberg test with multiple alleles (Guo and Thompson, 1992), as
implemented in the program GenePop 3.4.

* An inter-class correlation test analysis (Burrows' composite measure of linkage
disequilibria between pairs of loci and X? tests for significance [Weir, 1996])
was performed separately in each population to detect any correlations between
alleles at any of the pair-wise comparisons of the 15 loci, using the program
PopGene 1.32.

Observed heterozygosity (Ho), expected heterozygosity, information content, and
tests for detecting departures from Hardy-Weinberg equilibrium are shown for each
population in Table 11. While a number of the chi-square tests gave seemingly
significant p-values (putatively indicating departures from Hardy-Weinberg
equilibrium), chi-squared tests are very sensitive to small expected values (as in the
case of multiple rare alleles where the expected number of certain genotypes is 1 or
fewer, such as with some of these markers), and can greatly inflate the test statistic in
this situation (Weir, 1990). With the exact test, the number of tests with p-value <
0.05 were 0 in the African American and U.S. Caucasian populations, 1 in the U.S.
Hispanic population (D8S1179; p=0.0304) and 2 in the Native Americans (D21S11,
p=0.0118; D5S818, p=0.0205). These are no more than would be expected by
chance. No more alleles were observed to be in linkage disequilibrium than would be
expected by chance alone. The average observed heterozygosity across the 15 STR
loci was 0.804 in the African American population, 0.792 in the U.S. Caucasian
sample population, 0.793 in the Hispanic sample population, and 0.757 in the Native
Americans. The most heterozygous locus was FGA (mean observed heterozygosity
across all populations of 0.875), and the least heterozygous STR locus was TPOX
(mean observed heterozygosity across all populations of 0.677).

Table 11 Heterozygosity and p-values for Hardy-Weinberg tests of the
15 Identifiler® Plus Kit STR loci in four U.S. populations #

Ameriemn Gancanian U'?r" ngg)"ic Amorioan
(n = 357) (n = 349) (n = 191)
CSF1P0
HW X2 p 0.13649 0.926431 0.951476 0.839278
HW G2 p 0.08902 0.894972 0.918038 0.728023
HWExactp  0.0762 0.2688 0.5456 0.6148
HExp 0.7829 0.7267 0.7051 0.7398
Ho 0.7703 0.7421 0.7138 0.7958
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Table 11 Heterozygosity and p-values for Hardy-Weinberg tests of the
15 Identifiler® Plus Kit STR loci in four U.S. populations (continued)*

AAr::eI:ii::r:n Cal:t:éian U.S. Hispanic A:if'li‘tl:ean

(n = 357) (n = 349) (n=290) (n = 191)
D251338
HW X2 p 0.409878 0.537758 0.975972 0.722543
HW G2 p 0.962501 0.407932 0.973054 0.760953
HW Exact p 0.7838 0.3488 0.9794 0.5825
HExp 0.8936 0.8823 0.8529 0.8428
Ho 0.8768 0.8653 0.8379 0.801
D351358
HW X2 p 0.947371 0.670787 0.681659 0.087223
HW G2 p 0.907905 0.654776 0.852278 0.175807
HW Exact p 0.2967 0.2814 0.4684 0.0614
HExp 0.7681 0.7986 0.7361 0.7028
Ho 0.7955 0.8166 0.7414 0.7382
D5S818
HW X2 p 0.993751 0.859805 0.944725 0.073002
HW G2 p 0.989776 0.520417 0.979044 0.08025
HW Exact p 0.958 0.462 0.4662 0.0205
HExp 0.7476 0.6931 0.7351 0.7378
Ho 0.7479 0.7077 0.7586 0.6806
D7S820
HW X2 p 0.987668 0.571989 0.336834 0.324754
HW G2 p 0.969887 0.44694 0.687948 0.289733
HW Exact p 0.9818 0.2286 0.4028 0.1276
HExp 0.7758 0.8117 0.7822 0.7858
Ho 0.7955 0.7908 0.7862 0.7487
D8S1179
HW X2 p 0.067164 0545414 0.047783 0.446248
HW G2 p 0.568837 0.275218 0.302937 0.760077
HW Exact p 0.2176 0.3264 0.0304 0.1656
HExp 0.7925 0.8047 0.7853 0.7403
Ho 0.7899 0.8424 0.8 0.6806
D13S317
HW X2 p 0.014379 0.711127 0.353995 0.813948
HW G2 p 0.609389 0.871173 0.190736 0.814681
HW Exact p 0.3818 0.667 0.2415 0.6851
HExp 0.6977 0.7797 0.8251 0.8222
Ho 0.6695 0.7364 0.8207 0.8168
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Table 11 Heterozygosity and p-values for Hardy-Weinberg tests of the
15 Identifiler® Plus Kit STR loci in four U.S. populations (continued)*
AAr::eI:ii::r:n Cal:t:éian U.S. Hispanic Amzf'li‘tl;n
(n = 357) (n = 349) (n =290) (n = 191)
D16S539
HW X2 p 0.433216 0.67702 0.058631 0.996396
HW G2 p 0.482435 0.594871 0.37601 0.981384
HW Exact p 0.3753 0.4328 0.3068 0.9986
HExp 0.7939 0.7632 0.7747 0.7766
Ho 0.8263 0.7822 0.7828 0.7853
D18S51
HW X2 p 0.999844 0.628334 0.999203 0.343027
HW G2 p 1 0.872113 0.999492 0.798859
HW Exact p 0.978 0.0982 0.9152 0.2265
HExp 0.8694 0.8769 0.8761 0.8463
Ho 0.8824 0.8682 0.8862 0.8377
D19S433
HW X2 p 0.91703 0.806717 0.731222 0.810711
HW G2 p 0.83419 0.999765 0.975476 0.898389
HW Exact p 0.4517 0.69 0.3475 0.4301
HExp 0.8364 0.7659 0.8310 0.8430
Ho 0.8011 0.7622 0.8414 0.822
D21S11
HW X2 p 0.985687 0.936146 0 0
HW G2 p 1 0.999757 0.999794 0.712937
HW Exact p 0.7627 0.7861 0.6476 0.0118
HExp 0.8585 0.8427 0.8290 0.8003
Ho 0.8711 0.8567 0.7931 0.801
FGA
HW X2 p 0 0.904953 0.263223 0.999686
HW G2 p 1 0.999812 0.960137 0.999946
HW Exact p 0.9761 0.4459 0.0891 0.9161
HExp 0.8659 0.8686 0.8751 0.8746
Ho 0.8824 0.8854 0.8724 0.8482
THO1
HW X2 p 0.961911 0.997905 0.649467 0.329461
HW G2 p 0.940414 0.99169 0.617212 0.318591
HW Exact p 0.8286 0.9716 0.4495 0.1377
HExp 0.7323 0.7866 0.7666 0.7016
Ho 0.7395 0.7822 0.8103 0.6492
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Table 11 Heterozygosity and p-values for Hardy-Weinberg tests of the
15 Identifiler® Plus Kit STR loci in four U.S. populations (continued)*

AA;Z(;::::n Cal:Jc.:éian U.S. Hispanic A:i?i‘::ean
(n = 357) (n = 349) (n=290) (n = 191)
TPOX
HW X2 p 0.765163 0.801518 0.875348 0.333914
HW G2 p 0.611014 0.757735 0.913091 0.229017
HW Exact p 0.7247 0.5775 0.8356 0.0647
HExp 0.7643 0.6311 0.6607 0.6765
Ho 0.7563 0.6304 0.6759 0.6178
VWA
HW X2 p 0.925176 0.005048 0.641684 0.994248
HW G2 p 0.964308 0.218817 0.934427 0.997184
HW Exact p 0.7033 0.0564 0.7066 0.8845
HExp 0.8141 0.8081 0.7818 0.7457
Ho 0.8571 0.8138 0.7759 0.7277

+ HW X2 p, probability value of X? test for Hardy-Weinberg equilibrium; HW G2 p, probability value of the
G-statistic of the Likelihood Ratio test for multinomial proportions; HW Exact p; A Markov chain
unbiased exact test to estimate the P-value of the Hardy-Weinberg test with multiple alleles; Hexp,
Expected heterozygosity; Ho, observed heterozygosity

Concordance We analyzed >500 samples by comparing allele calls between the AmpF{(STR
studies Identifiler and Identifiler® Plus Kits. The genotype data from all the analyzed
samples showed 100% concordance between the Identifiler and Identifiler® Plus
Kits.
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Mutation Rate

Mutation Rate

Estimation of spontaneous or induced germline mutation at genetic loci can be
achieved by comparing the genotypes of offspring to those of their parents. From
such comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by the
AmpF(STR SGM Plus™ PCR Amplification Kit were determined for a total of 146
parent-offspring allelic transfers (meioses) at the Forensic Science Service,
Birmingham, England. One length-based STR mutation was observed at the D18S11
locus; mutations were not detected at any of the other nine STR loci. The D18S11
mutation was represented by an increase of one 4-nt repeat unit, allele 17 was
inherited as allele 18 (single-step mutation). The maternal/paternal source of this
mutation could not be distinguished.

Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong,
mutation studies 1993; Hammond et al., 1994; Brinkmann et al., 1995; Chakraborty ef al., 1996;
Chakraborty et al., 1997; Brinkmann et al., 1998; Momhinweg et al., 1998; Szibor et
al., 1998) of direct mutation rate counts produced:

+ Larger sample sizes for some of the AmpF(STR® Identifiler® Plus Kit loci.

* Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).
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Probability of Identity

Table 12 shows the Probability of Identity (PI) values of the AmpF{STR® Identifiler®
Plus Kit loci individually and combined.

Table 12 Probability of Identity values for the AmpF{STR Identifiler Plus Kit

STR loci

Locus AAr:ltl(:ia::r;-n Cat:Jc.:éian U.S. Hispanic Agztii‘cl:ean
CSF1PO 0.079 0.132 0.141 0.123
D251338 0.023 0.027 0.038 0.043
D3S1358 0.097 0.076 0.112 0.158
D5S818 0.104 0.147 0.115 0.110
D7S820 0.085 0.063 0.083 0.081
D8S1179 0.074 0.064 0.089 0.104
D13S317 0.132 0.079 0.056 0.056
D16S539 0.077 0.097 0.090 0.082
D18S51 0.033 0.031 0.031 0.046
D19S433 0.042 0.087 0.049 0.044
D21S11 0.037 0.044 0.047 0.074
FGA 0.034 0.035 0.032 0.031
THO1 0.109 0.079 0.097 0.134
TPOX 0.089 0.188 0.168 0.159
VWA 0.066 0.066 0.080 0.103
Combined 1.31 X 10718 5.01 X 10718 7.65X 10718 3.62 X 10717

The P, value is the probability that two individuals selected at random will have an
identical AmpF{STR Identifiler Plus Kit genotype (Sensabaugh, 1982). The P, values
for the populations described in this section are then approximately 1/7.64 X 10'7
(African-American), 1/2.00 X 10'7 (U.S. Caucasian), 1/1.31 X 10'7 (U.S. Hispanic),
and 1/2.76 X 10'® (Native American).
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Probability of Paternity Exclusion

Table 13 shows the Probability of Paternity Exclusion (Pg) values of the AmpF(STR®
Identifiler® Plus Kit STR loci individually and combined.

Table 13 Probability of Paternity Exclusion values for the AmpF/STR
Identifiler Plus Kit loci

Locus AArIIZ(;ia::r;-n Cal:jc'ass.;ian U.S. Hispanic Ar';l'lae:ii‘g:n
CSF1PO 0.545 0.496 0.450 0.409
D251338 0.748 0.725 0.671 0.399
D351358 0.591 0.630 0.495 0.510
D55818 0.506 0.440 0.525 0.601
D7S5820 0.591 0.582 0.574 0.492
D8S1179 0.580 0.680 0.599 0.601
D13S317 0.383 0.487 0.638 0.370
D16S539 0.649 0.566 0.567 0.428
D18S51 0.760 0.731 0.767 0.329
D19S433 0.601 0.531 0.678 0.360
D21S11 0.737 0.708 0.586 0.399
FGA 0.760 0.766 0.739 0.309
THO1 0.492 0.566 0.618 0.646
TPOX 0.521 0.329 0.392 0.687
VWA 0.709 0.625 0.555 0.528
Combined 0.9999996 0.9999992 0.9999990 0.9999527

The P, value is the probability, averaged over all possible mother-child pairs, that a

random alleged father will be excluded from paternity after DNA typing of the
AmpF(STR Identifiler Plus Kit STR loci (Chakraborty and Stivers, 1996).
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Troubleshooting

Follow the actions recommended in Table 14 to troubleshoot problems that occur
during analysis.

Table 14 Troubleshooting

Observation

Possible causes

Recommended actions

Faint or no signal from
both the 9947A and the
DNA test samples at all
loci

Incorrect volume or absence of either
AmpF{STR Identifiler® Plus Master
Mix or AmpF{STR Identifiler® Plus
Primer Set

Repeat amplification.

No activation of enzyme

Repeat amplification, making sure to hold reactions
initially at 95 °C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF{STR Identifiler® Plus Primer
Set exposed to too much light

Store Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’'s manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into contact with block
after first cycle. Repeat test.

Wrong PCR reaction tube

Use Applied Biosystems® MicroAmp Reaction

Tubes with Caps for the GeneAmp® PCR System
9700.

MicroAmp® Base used with
tray/retainer set and tubes in
GeneAmp® PCR System 9700

Remove MicroAmp Base from tray/retainer set and
repeat test.

Insufficient PCR product
electrokinetically injected

For ABI PRrism® 3100-Avant or Applied
Biosystems® 3100/3130x/ runs: Mix 1.0 uL of
PCR product and 9 uL of Hi-Di™ Formamide/
GeneScan™ 500 LIZ® solution.

For ABI PRiISM® 310 instrument runs: Mix
1.5 pL of PCR product and 25 uL of Hi-Di™
Formamide/GeneScan™ 500 LIZ® solution.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Table 14 Troubleshooting (continued)

Observation

Possible causes

Recommended actions

Positive signal from
AmpF{STR Control DNA
9947A but partial or no
signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantitate DNA and add 1.0 ng of DNA. Repeat
test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantitate DNA and add minimum necessary vol-
ume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely degrad-
ed

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded, ream-
plify with an increased amount of DNA or use the
AmpF{STR® MiniFilerKit.

Dilution of test sample DNA in water or
wrong buffer (for example, TE formula
with incorrect EDTA concentration)

Redilute DNA using low TE Buffer (with 0.1 mM
EDTA).

More than one allele
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

See “Stutter products” on page 90.

Incomplete 3" A base addition (n-1 nt
position)

See “Addition of 3" A nucleotide” on page 95. Be
sure to include the final extension step of 60 °C
for 10 min in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 30. Repeat PCR
amplification using fewer PCR cycles or use your
laboratory’s SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA
(1.0 ng).

Some but not all loci
visible on
electropherogram

Test-sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or use
the AmpF{STR® MiniFiler "Kit.

Test sample contains high
concentrations of a PCR inhibitor (for
example, heme compounds, certain
dyes)

Quantitate DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.
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Table 14 Troubleshooting (continued)

Observation

Possible causes

Recommended actions

ance

Poor peak height bal-

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

GeneAmp® PCR System 9700 with
Aluminum 96-Well block or third-
party thermal cyclers

Use Applied Biosystems® GeneAmp® PCR
System 9700 with silver or gold-plated silver
blocks only.
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Safety

This appendix covers:

B Chemical safety.......... ... . e 132
B Chemical wastesafety............. ...ttt 134
B Biological hazardsafety ........... ... ... .. ... i 135
B Chemicalalerts ......... ... .. 136

AmpFISTR® Identifiler® Plus User Guide 131



Appendix B Safety

Chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer

warning

to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

ﬁ WARNING! CHEMICAL HAZARD. All chemicals in the instrument,

including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

é WARNING! CHEMICAL HAZARD. Four-liter reagent and waste bottles

can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked
in the upright position. Wear appropriate eyewear, clothing, and gloves when
handling reagent and waste bottles.

é WARNING! CHEMICAL STORAGE HAZARD. Never collect or store

waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 133.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

Comply with all local, state/provincial, or national laws and regulations related
to chemical storage, handling, and disposal.
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Chemical safety

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS
part number, or other information that appears in the MSDS of interest. Select
the language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:

*  Open — To view the document
* Print Target — To print the document

» Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the MSDSs of chemicals not distributed by us, contact the chemical
manufacturer.
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Appendix B Safety

Chemical waste safety

Chemical waste ﬁ WARNING! HAZARDOUS WASTE. Refer to Material Safety Data Sheets

hazards

and local regulations for handling and disposal.

WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

é WARNING! CHEMICAL STORAGE HAZARD. Never collect or store

waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover fastened
and the handles locked in the upright position. Wear appropriate eyewear,
clothing, and gloves when handling reagent and waste bottles.

Chemical waste To minimize the hazards of chemical waste:

safety guidelines .

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle,
or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you
must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.
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Biological hazard safety

* Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

General @ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

biohazard infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective equipment, which
includes but is not limited to: protective eyewear, face shield, clothing/lab coat,
and gloves. All work should be conducted in properly equipped facilities using
the appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

* U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no.
017-040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html)

* Your companys/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Appendix B Safety

Chemical alerts

General alerts for

all chemicals

Specific
chemical alerts

Avoid contact with skin, eyes, and/or clothing. Read the MSDS and follow the
handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

/N

CAUTION! CHEMICAL HAZARD. AmpF(STR® Identifiler® Plus PCR
Amplification Kit may cause eye, skin, and respiratory tract irritation. Sodium
azide may react with lead and copper plumbing to form highly explosive metal
azides.

/N

WARNING! CHEMICAL HAZARD. POP-4™ Polymer for 3130/3130x!/
Genetic Analyzers causes skin, eye, and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Running Buffer, 10X causes skin,
eye, and respiratory tract irritation.

WARNING! CHEMICAL HAZARD. Hi-Di"" Formamide is harmful if
swallowed, inhaled or absorbed through skin, and causes irritation to skin,
eyes, and respiratory tract. It affects the central nervous system and may affect
the reproductive system.

WARNING! CHEMICAL HAZARD. POP-4" Polymer for 3100/3100-
Avant Genetic Analyzers is irritating to eyes, respiratory system, and skin. It
causes adverse cardiovascular effects. It contains a known or suspected
reproductive toxin and a known or suspected mutagen.
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Related documentation

Document title

Applied Biosystems® 3100/3100-Avant Data Collection v2.0 User Guide
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Guide
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Quantification Kit User’s Manual
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AmpFISTR® Identifiler® PCR Amplification Kit User’s Manual

Veriti® 96-Well Thermal Cycler AmpFISTR® Kit Validation User Bulletin
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GeneMapper® ID-X Software Version 1.0 Reference Guide

Part
number

4347102
4350218

4315834
4332345

4363787
4352715
4352716

4362825
4359472
4331468
4344790

4391294
4485354
4323291
4440754

100031595

4338775
4335523
4352543
4375574
4375670
4375671

AmpFISTR® Identifiler® Plus User Guide

141



Documentation

How to obtain support

For HID support:

* In North America — Send an email to HIDTechSupport@lifetech.com, or call
888.821.4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:
* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities
» Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application
notes, formulations, handbooks, certificates of analysis, citations, and other
product support documents

* Obtain information about customer training
* Download software updates and patches

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set
forth in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies’ website at www.lifetechnologies.com/termsandconditions. If you
have any questions, please contact Life Technologies at
www.lifetechnologies.com/support.
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D

data

accuracy, precision, and reproducibility 82

Data Collection Software 15
Data Collection Software, overview 15
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developmental validation 78
DNA
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control, about 17

degraded 102

effect of quantity, figure 101
mixture studies 105
mixture studies figure 107
negative-control reaction 28
positive-control reaction 28
quantification 25
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sample preparation 28
sensitivity 100

test sample 28

tools 24

DNA mixtures

E

amplification figure 109
limit of detection 107
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causes of extra peaks 84, 90
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species specificity 99, 102
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Data Collection Software 37, 39
preparing samples on the 310 instrument 40

preparing samples on the 3100/3100-4vant or
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reagents and parts 37, 39
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equipment, not included in kit 18
experiments and results 77
extra peaks, causes 90

F

fluorescent dyes 15

FTA cards
amplification 31
bloodstained 31

G

GeneMapper® ID Software
data analysis 47
overview 15, 46
GeneMapper® ID-X Software
data analysis 61
overview 15
GeneScan size standard
about 17
dye label 15
volume per reaction 38, 40
guidelines
chemical safety 132
chemical waste disposal 134
chemical waste safety 134

H

hazards. See safety
hematin 103
hematin, effects of 103

Hi-Di formamide, volume per reaction 38, 40

humic acid, effects of 104

inheritance 97
instrumentation

310 genetic analyzer 15, 36, 39
3100/3100-Avant genetic analyzer 15, 36, 37
3130/3130x/ genetic analyzer 15, 36, 37

software compatibility 15

K

kit
allelic ladder 17
amplification 10
contents 17
control DNA 17
description 10
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loci amplification 11

master mix 17

primers 10, 17, 26

purpose 10

reagents 17

supported instruments 10
kit performance, comparisons

DNase I 102
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L

limited product warranty 142
LIZ size standard
about 17
volume per reaction 38, 40
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dye label 11
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low TE buffer 25

M

magnesium chloride concentration, validation of 79
master mix, volume per reaction 28
materials and equipment

included in kit 17

not included in kit 18
mixed samples, resolution of genotypes 106
mixture studies 105
MSDSs

description 133

obtaining 133
multicomponent analysis 15, 16
mutation studies 123
mutation, STR 123

N

negative control, sample preparation 28

0]

off-ladder alleles 83
operating systems 37, 39

P

PCR
hematin, inhibitor 103
humic acid, inhibitor 104
performing 30
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setup tools 24

thermal cycling conditions, programming 30

work area setup 24
PCR components, validation of 79
PCR cycle number, validation 80
peak height ratios, table of alleles 105
percent stutter

highest value for locus 91

off-scale peaks 91

relation to allele length 91
positive control, sample preparation 28
precision and size windows 83
precision, sizing 83
primers

Amelogenin 97

volume per reaction 28
probability of identity

definition 124

values 124

Q

quantification, DNA 25

R

radioactive waste, handling 135
reaction mix, for PCR 28
reactions, preparing for PCR 28
reagents, user supplied 25

run module, electrophoresis 37, 39

S

safety
biological hazards 135
chemical waste 134
guidelines 132, 134
sample files, .fsa 47, 61
sample preparation 28
DNA negative control 28
DNA positive control 28
standards 17
setup tools, PCR 24

size deviation, sample alleles and ladder alleles 82

sizing precision 83

software, instrument compatibility 15
species specificity 98

split peaks, +A nucleotide addition 95
STRBase 111

stutter products 90

T

thermal cycling

parameters, validation of 80
programming conditions 30

training, information on 142

U

user-supplied reagents 25

\"

validation

W

annealing temperatures 80
characterization of loci 97
developmental 78

effect of DNA quantity 100
experiments to evaluate 78
importance of 78

magnesium chloride concentration 79
mixture studies 105

mutation rate 123

PCR cycle number 80

population data 111

probability of identity 124
probability of paternity exclusion 125
sensitivity 100

size deviation, sample and ladder alleles 82

species specificity 98
thermal cycling parameters 80

warranty 142

waste disposal, guidelines 134
waste profiles, description 134
work area

amplified DNA tools 24
PCR tools 24
setup 24

workflow overview 14
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